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This tutorial series introduces you to the MatlabR2006b suite of applications from Mathworks, 
Inc.  The R2006b release consists of version 7.3 of the primary Matlab application along with 
some auxiliary modeling and simulation applications and specialized toolboxes.  The suite as a 
whole will be surveyed but the primary application, Matlab 7.3, will be the focus of the tutorial 
sections designed for getting started.  Instruction is aimed toward first-time users; however, those 
who are already familiar with previous versions of Matlab can use this document to learn about 
some of Matlab’s new features and graphical interface.  The tutorial series is organized into four 
parts containing a total of nine sections.  
 
Part I includes the first four sections and serves to get the user acquainted with the Matlab 
application. The first section provides a brief introduction to this tutorial series and to Matlab.  
The second section gives an overview of the Matlab desktop layout and guides the reader through 
each of the windows and their functions.  Also covered in this section is the layout for the built-in 
Matlab Help.  The third section covers the basic methods of getting data into and exporting data 
from Matlab, including the import wizard, command line I/O functions, and M-books.  The 
fourth section introduces the notation and syntax used by Matlab and contains essential 
information for routine usage of the application. 
 
Part II includes the fifth and sixth sections which serve to introduce the basic functionalities of 
the Matlab application such that the user will be able to perform routine tasks.  The fifth section 
covers computational and numerical methods for doing various mathematical operations.  The 
sixth section goes through the basics of programming in the Matlab programming language and 
the construction of M-files, which are callable scripts, macros, and functions that can be used 
from the Matlab command line prompt or can be nested within another such file.  
 
Part III includes the seventh and eighth sections and covers aspects of manipulating and 
visualizing properties of data sets, including experimental data that have no assumed functional 
relationships a priori.    The seventh section treats aspects of graphical display and data 
visualization, particularly plots.  An eighth section covers several ways in which Matlab can be 
used in the analysis of experimental or collected data.
 
Part IV encompasses the ninth and final section which deals with optimization methods and with 
modeling and simulation of dynamical systems.  This last section includes an introduction to the 
auxiliary Simulink application that is distributed with Matlab.  Also, this section will introduce 
the usage of Matlab Toolboxes, which are ensembles of related M-files developed for specific 
types of applications.
 
Throughout this document many concepts and techniques are illustrated using Matlab scripts and 
other auxiliary files.  Links to electronic copies of these files are provided within the tutorial text 
as they are needed, but there is also a central location where all associated files can be 
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downloaded from links on the same web page:
 
http://www.utexas.edu/its/rc/tutorials/matlab/matlabdemofiles.html
 
 
Introduction to Matlab
 
In the 1960s and 1970s before the appearance of personal computers, complex and large scale 
calculations were done on large mainframes using code primarily developed with FORTRAN.  
As a number of related large subroutines were developed for specific computational purposes, 
they were organized into public domain packages and distributed for free.  Matlab was originally 
created as a front end for one of these, the LINPACK package -- a group of routines for working 
with matrices and linear algebra.  The primary developer, Professor Cleve Moler at the University 
of New Mexico, eventually founded Mathworks, Inc., to further develop and market the product 
in a commercial setting.  From the original Matlab, a high powered suite of applications has 
evolved.  The current generation release, the MatlabR2006b suite, features the newest kernel, 
Matlab 7.3.  It is largely backward compatible with recent Matlab versions, but there may be 
some slight changes.  
 
 
 

Section 2: An Overview of Matlab 
 

Access to Matlab and ITS Matlab consulting services
 
Information Technology Services (ITS) at UT-Austin provides free Matlab access to students, 
faculty, and staff on its time sharing mainframes, or via the desktop computers in the Student 
Microcomputer Facility (SMF) on the second floor of the Flawn Academic Center (FAC 212).  
To login to these machines it will be necessary to have a UT EID. individually funded (IF) or 
departmental sponsored account issued by ITS.  There is no cost for using software such as 
Matlab in the SMF although other ITS charges may be incurred if output is being printed or 
stored on time sharing server disk space.  Information about getting an ITS- issued account to 
accommodate printing and storage is available at
 
    http://www.utexas.edu/its/account/index.html
 
A contemporary version of Matlab is installed on the ITS UNIX systems: ccwf.cc.utexas.edu and 
larry.cc.utexas.edu, which run on Solaris 8.    A Windows version of Matlab is installed on the 
ITS applications Windows terminal server, wts.austin.utexas.edu.  To access these installations, 
an ITS-issued account must have CCWF validation (piglet), UTS validation (larry), or AMS 
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validation (wts).   Note that CCWF validations are no longer being issued, thus new users will 
need UTS validation if a UNIX environment is desired.  Some academic departments (e.g., 
Chemical Engineering) also have Matlab already installed on machines in their local computer 
labs.  Also, UT-Austin departments are eligible to purchase licenses for Matlab for use within 
their own labs through the Software Distribution Services unit of ITS.  Details of various 
licensing options available for purchase by academic departments are available at
 
     http://www.utexas.edu/its/sds/products/matlab.html
 
The most current Matlab suite containing Matlab and its optional auxiliaries and toolboxes is also 
marketed directly by Mathworks, Inc., which has special academic pricing; and, for individuals 
enrolled as students, a very inexpensive student edition with full functionality is available.  
Information and pricing is given at
 
     http://www.mathworks.com/store/index.html
 
The Campus Computer Store in VRC also sells the student version of Matlab.  A currently valid 
student ID is needed for purchase.
 
ITS provides free consulting for UT-Austin student, faculty, and staff members using Matlab for 
education and research purposes.  However, direct assistance with homework, class assignments, 
or projects of a commercial nature is not available.  Appointments for walk-in or phone 
consulting can be made at
 
http://www.utexas.edu/cc/amicus/index.html
 
and questions can be submitted via the web form
 
http://www.utexas.edu/its/rc/ehelp-math.html
 
or by direct e-mail to math@its.utexas.edu.
 
 
Getting Started
 
Mathworks, Inc. now is on a semiannual cycle for releasing updates of Matlab and its various 
auxiliaries, so the version installed on the ITS servers may be changing periodically.  The 
procedure for launching Matlab is no different from one version to the next. However, the launch 
method varies.
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●     With UNIX, the environment PATH variable must include the directory containing the 
Matlab installation. On the ITS UNIX systems this directory is /usr/local/matlab and there 
is a script that will automatically augment the PATH variable with necessary additions.  
This script can be run from a shell prompt with the command eval`/usr/local/etc/
appuser`. Please note that backquotes should be used rather than ordinary single 
quotes. 

If the Matlab application is being run on a remote X terminal using a UNIX mainframe 
application, then the DISPLAY variable has to be set to the local terminal and the local 
terminal has to grant access to the UNIX mainframe.  Both of these requirements can be 
circumvented if the mainframe connection is through a secure shell (SSH) protocol.  
Otherwise the commands  
 
setenv DISPLAY myhost.mydomain:0.0  
xhost +remotesystem.remotedomain 

 
will need to be executed at the shell prompt. Matlab can then be started at a shell prompt 
with the command matlab, or, in background with concurrent access to other processes 
with the command matlab &.  

 
●     The Windows distribution can be launched by double clicking on a Matlab icon or 

shortcut.  The default working path in this distribution consists of the Work subfolder of 
the top level installation folder and the hierarchy within the Toolbox subfolder of the top 
level installation folder.  Access to files in other folders can be set by navigating with the 
browser from the Set Path option of the File pull down menu.

 
The Desktop Layout
 
Once the path environment is set properly and the desktop appears on the monitor screen, using 
Matlab will be practically the same for all operating system distributions.  There are several 
windows that can be used in arranging the desktop, but a default configuration will appear upon 
launching.  If desired this can be modified by selecting an alternate choice from Desktop -> 
Desktop Layout on the top navigation bar.   This tutorial will use the default layout for 
MatlabR2006b package, which is currently the ITS supported production version.  There may be 
minor variations in future releases.  The default desktop for MatlabR2006b has a small Current 
Directory selection window near the top, with the Work folder being specified initially.  If other 
folders have been added, then another current directory setting can be selected from among those 
available.  The main area has the Command window on the right and an upper and lower window 
on the left side. The upper left panel will show a Current Directory window which can be toggled 
with a Workspace window.  The lower left panel will show a Command History window.    There 
are also undocked informational windows that can be launched from Help > MATLAB Help and 
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Help > Demos, and there is an undocked Figure window that is launched whenever a command 
involving graphical display is executed.
 

 
 

The Current Directory Window
 
. The Current Directory window displays a current directory with a listing of its contents.  There 
is navigation capability for resetting the current directory to any directory among those set in the 
path.  This window is useful for finding the location of particular files and scripts so that they can 
be edited, moved, renamed, deleted, etc.  The default current directory is the Work subdirectory 
of the original Matlab installation directory.  By default its contents are displayed in the upper left 
area of toggled windows when the application is first launched or when Desktop > Desktop 
Layout > Default is selected from the navigation bar.
 
 
The Workspace Window
 
The Workspace window provides an inventory of all the items in the workspace that are currently 
defined, either by assignment or calculation, in the Command window or by importation with a 
load or similar command from the Matlab command line prompt. These items consist of the set 
of arrays (including 1x1 scalars) whose elements are variables or constants and which have been 
constructed or loaded during the current Matlab session and have remained stored in memory.  
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  Those which have been cleared and no longer are in memory will not be included.  The 
Workspace window shows the name of each variable, its value or array size and if numerical, the 
minimum and maximum values among constituent elements.  Values of a variable or constant can 
be edited in an Array Editor which is launched by double clicking its icon in the Workspace 
window. 
 
From the Workspace window, it is also possible to generate a graph of a multi-element vector or 
matrix variable. To create a graph, choose a variable, click the graph button on the Workspace 
window toolbar, and select the graph type from the pull down menu. The graph appears in a 
figure window. The button itself changes to reflect the currently selected style of graph. In 
addition, you can use the right-click in Windows (or the equivalent button or keystroke operation 
for other operating systems) on the variable you want to graph. The type of graph desired can 
then be chosen from the context menu. It is also possible to select multiple variables to graph 
together. The values of a variable or values within a selected range of contiguous elements can 
also be displayed in graphic form after opening in an Array Editor window, which will have a 
graphing button with a pull down menu for type.  The right-click procedure for graphical viewing 
of an array variable can likewise be used after selecting elements in an Array Editor window. 
 
 
The Command History Window
 
The Command History window, at the lower left in the default desktop, contains a log of 
commands that have been executed within the Command window.  This is a convenient feature 
for tracking when developing or debugging programs or to confirm that commands were 
executed in a particular sequence during a multi-step calculation from the command line.
 
 
The Command Window
 
. The Command window is where the command line prompt for interactive commands is located.  
This is also the only window that appears if you execute the UNIX version of Matlab outside of 
an X environment, e.g., on a vt100 screen.  Commands and scripts can be executed from a vt100 
window, but graphics and desktop tools will not be available.  The Matlab prompt on the 
command window consists of two adjacent right angle brackets, i.e., >>.  Results of command 
operations will also be displayed in this window unless the command line is terminated by a semi-
colon, in which case the display of results is suppressed.  If a command or script specified on the 
command line is questionable or cannot be executed because of invalid syntax, undefined 
variables, etc., a diagnostic message will be displayed in the Command window.  The current 
value of any saved variable is also displayed in this window if its name is entered at a prompt.
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The Help Window
 
Separate from the main desktop layout is a Help desktop with its own layout.  This utility can be 
launched by selecting Help ->MATLAB Help from the Help pull down menu. This Help desktop 
has a right side which contains links to help with functions, help with graphics, and tutorial type 
documentation.  The left side has various tabs that can be brought to the foreground for 
navigating by table of contents, by indexed keywords, or by a search on a particular string.
 

 
 
The Figure Window
 
There is a Figure window that floats independently from the main desktop.  If not already present, 
it is launched when command execution results in graphical output.  From the Edit menu on the 
main toolbar, there are selections for editing figure properties, axis properties, and properties of 
objects within figures.  On the Tools menu of the main toolbar there are selections for further 
manipulation such as zooming and perspective rotation.  There is also a main toolbar menu for 
Help, which includes specific graphics help and demos.
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Section 3: Notation, Syntax, and Operations

 
Like other command driven applications, Matlab requires information to be presented in a certain 
manner in order to be properly interpreted.  It is a bit more rigid than some, for example case 
sensitivity for names of constants and variables, and a bit more flexible than others, for example 
many default values and interpretations for missing or incomplete arguments.  
 
Variable names
 
The case sensitive names of variables and assigned constants can contain any of the 26 lower case 
and 26 upper case letters of the standard Latin alphabet along with the ten digits between 0 and 9 
and the underscore.  A name can be any sequence of 1 to 31 of these characters, but the first must 
be an upper or lower case letter and there cannot be any embedded blank spaces.  Names longer 
than 31 characters are permitted but only the first 31 are used for unique identification.  Constants 
and variables can be assigned values using the assignment operator, a single equal character ( = ), 
e.g.,  a = 3.
 
Numerical conventions
 
Matlab uses standard numerical notation.  Numeric variables and constants are stored and 
displayed as sequences of base 10 digits.  The radix point for fraction expansion is the period ( . ), 
and the lower case letter e is used for floating point exponent representation.  Note that this is not 
the natural logarithm base "e".  The e must be immediately followed by a + or – sign and then an 
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integer.  The + is optional for positive exponents, and arbitrary preceding zeros are permitted.  
For example,  the integer 2000  can be represented as  2.0e+003,  2e3,  0002.000e0003, or even 
with a negative exponent as 20000e-1; and the fraction  can be represented as 0.0005, 5e-4, 
or 05.0000e-00004, or even with a positive exponent as 0.00005e001.
 
Matlab accommodates complex-valued numbers of two dimensional divisional algebra using the 
symbols i and j as default notations for .  These two symbols are initially identical, 
accommodating an historical notational difference between mathematical literature and 
engineering literature.  They are not the separate roots of -1 in the classical i j k notation of 
higher dimensional divisional algebras such as Hamiltonian quaternions, and in fact k does not 
have an initial built-in assigned value.  Once i or j has been assigned some value the symbol must 
be immediately preceded by a numerical value in order to signify an imaginary part.  If not, it will 
be interpreted as a separate entity.  Thus:
 
(1 +  1i  ) is a single complex number with magnitude 1 for both real and imaginary parts
(1 +  1*i) is a sum of the integer 1 and whatever value i happens to have at the time
 
Although i has an initial built-in value of , it can be overwritten by assignment, and it 
frequently is because that letter is used routinely to denote an index counter in loops.
 
Geometrical and directional conventions
 
Most of Matlab’s geometrical and directional conventions should be familiar.  The principal 
domain for multivalued functions is symmetrically centered around zero, so that, for example, the 
inverse sine function asin has the principal domain [-π/2, + π/2].  When a branch cut is needed 
for analytic continuation in the complex plane, it typically extends from a point on the real axis to 
negative infinity along that axis.  Angles in the complex plane or in polar coordinates are 
considered positive when measured in a counterclockwise sense.  Likewise the chirality of 
multidimensional coordinate systems is established by the counterclockwise (right hand thumb) 
rule: if the fingers of the right hand are curled from the positive nth axis toward the positive (n+1)
th axis then the right thumb will point in the positive direction of the orthogonal (n+2)th axis.  Of 
course in terms of plotting and visualization, dimensionality is limited to 3.  For data analysis 
using matrix techniques, Matlab interprets columns as variables with rows as observations.
 
 
 
 
Operator and delimiter symbolics
  
Basic Matlab notation essential for computation includes symbols that distinguish between 
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operations on elements within matrices and between matrices as a whole.  The difference 
between these all stem from the fundamental definition of matrix multiplication specifying that a 
product matrix element is the inner product of  the corresponding row vector of the left hand 
component with the column vector of the right hand component, e.g.,
 

  and       
 
The Matlab notation for binary operations on matrices, vectors, and their elements are as follows:
 
+  for matrix or element addition
-   for matrix or element subtraction
.*  for element multiplication
*   for matrix multiplication
./   for element division
/    for right matrix division (right multiplication by an inverse)
\    for left matrix division (left multiplication by an inverse)
 
There is also Matlab notation for a few unary operations
 
.^  for raising an element to a power
^   for raising a matrix to a power
'    for converting to complex conjugate transpose (single forward quote)
 
Matlab also has specific notation and symbols for delimiters, separators, grouping, type 
assignment, and so forth:  Essential among these are:
 
 [  ]  for vector and matrix delimiter       
 (  )  for grouping, vector and matrix element indices, function argument delimiter
 :     for index range separator  
 ;     for matrix row separator
       blank space for matrix column element separator 
 ,    comma for matrix index separator, function argument separator
 .    period for radix expansion separator (American convention)
'  '  single forward quotes for demarcation of character strings
 
 
The Matlab notation for Boolean logicals uses the following symbols:
 
= =  for logical equality 
&    for AND 
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|       for inclusive OR, 
~      for NOT
<=   for less than or equal,  
>=   for greater than or equal
~=   for not equal, 
1      for true,  
0      for false.
 
There is not a specific symbol notation for an exclusive OR, but there is a functional equivalent: 
xor(p,q) is the same as the compound logical (p & ~q) | (~p & q).
 
Matlab also has special interpretation for certain symbols related to positioning within a line of 
command instruction or code.  Important and commonly used examples are:
 
Ignore Further Text:       %  anywhere in a line (uncompiled comment for rest of the line)
Suppress Display:            ;  at the end of the line 
Continue on Next Line:   … (three periods) at the end of a line
 
When working interactively at a keyboard, Matlab has a standard notation to indicate a status of 
being ready for input
 
>>  prompt for keyboard input in the command window
 
Also for interactive input from a keyboard, Matlab has a couple of standard notations to interrupt 
functioning.  These are:
 
^c   simultaneous control key and lower case c to stop execution and return to prompt
^q   simultaneous control key and lower case q to stop execution and exit Matlab
 
 
Multiple operations
 
Matlab accommodates multiple operations equivalent to macros in various other environments.  
A set of commands to be performed sequentially as a batch can be specified in a Matlab m-file.  
An m-file can be created by selecting File > New > M-file from the toolbar.  This opens up a 
floating editing window into which a sequence of commands can be entered.
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The contents of this window can then be saved to a particular file name using 
File > Save As from the Editor Window toolbar.  The save process will append a ".m" extension 
onto the file name given, letting Matlab know that it is an m-file.  If this example m-file is saved 
as my_macro.m then the sequence of commands within can be executed by typing the file name 
at a Command Window prompt
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If the same operation is to be iterated or repeated several times, Matlab has flow structures that 
can be used. As an example, suppose we want to create a vector whose elements are the 
differences between cubes and squares of some consecutive integers.  We could generate this 
using the for command
 
>> for n = 1:5
x = n^2;
y = n^3;
z(n) = y - x;
end;
>> z
 
z =
 
     0     4    18    48   100
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Note that the for command requires an end statement so that Matlab will know when to go on to 
the next index value.  Other similar commands which can accommodate multiple repeated 
operations, such as while, are discussed in section 5.
 
 
 
 
 
Displaying content of multi-element variables
 
When a created element is a vector or a matrix, such as the vector z above,  its contents can be 
displayed in a variety of plotting formats by selecting its icon in the Workspace Window and then 
selecting the plot type from the plotting icon in that same window.  A plot of the element values 
can also be produced from the command line in the Command Window.  With the example 
vector z, this can be done simply with 
 
>> plot(z)
 

 
In section 7 methods of customizing a display such as this will be presented.
 
 
 

http://www.utexas.edu/its-archive/rc/tutorials/matlab/ (17 of 145)11.09.2007 07:54:15



Matlab Tutorial

Section 4: Importing and Exporting Information
 
Information can be imported into and exported from the Matlab application by several different 
methods.  Some of the more common procedures are discussed below.  To follow the specific 
examples given, copies of the example external data files will need to be copied to a location 
where they can be accessed by the Matlab program.  Thus, before proceeding with this section, 
find the following documents  
 
http://www.utexas.edu/its/rc/tutorials/matlab/planetsize.txt  
http://www.utexas.edu/its/rc/tutorials/matlab/planets1.txt
http://www.utexas.edu/its/rc/tutorials/matlab/planets2.txt
http://www.utexas.edu/its/rc/tutorials/matlab/planets3.txt
http://www.utexas.edu/its/rc/tutorials/matlab/planetdata.doc 
http://www.utexas.edu/its/rc/tutorials/matlab/planets6.xls
 
and copy them into a location within the Matlab search path (for example, in the default work 
folder or directory).  If you cannot access these external documents, you can also find their ASCII 
text contents within this document.  Remember that the planetdata.doc and plantets6.xls files are 
binary and must be transferred in that mode
 
 
Command Line Import
 
The most elementary method for importing external information is piece by piece directly from 
the command line by typing at the keyboard.  For example:
 
>> earthradius = 6371;
 
will assign the numerical value 6371 to a variable earthradius.  For extensive amounts of 
information there are more efficient methods.
 
 
The Import Wizard
 
Matlab provides an Import Wizard for convenient importation of data from external files.  This 
tool can be activated by selecting File > Import Data, or by executing the  uiimport 
command at a Matlab command line prompt.  This utility can be used for importing both text and 
numerical data contained within the same data file, but entries have to be in a matrix format with 
specified column separators.  As an example, consider a small file, planetsize.txt, containing a 
few planets’ names, radii, and masses with columns separated by tabs:
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Planet   Radius  Mass-kg*10^24   
Earth    6371    5.97
Mars    3390    0.64
Venus   6052    4.87
 
This file can be imported directly with the command
 
>> uiimport planetsize.txt
 
or, with File > Import Data this file can be specified from a browse tool button.  With either 
method, the contents of the file will be displayed in a floating Import Wizard window.  A preview 
screen appears which lets you confirm the data importation, with separate tabs to examine the 
numerical data and the text fields:
 

 
To continue, click on the Next > button and a new screen lets you selectively choose which 
information from the file to import into the Matlab workspace.  The process is completed by 
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clicking Finish.
 
 

 
 
Import Functions
 
There are a variety of other ways to import complex data using the Command Window.  Below 
several of these functions are described in detail.
 
csvread
 
This function imports numeric data with comma-separated values (csv).  For example, in the 
planetary data above, suppose that we have an external file planets1.txt, containing the kilometer 
radial distances and 1024 kg mass values for Earth, Mars and Venus:
 
6371, 5.97
3390, 0.64
6052, 4.87
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The command  
 
>> planets1 = csvread('planets1.txt') 
 
would create a 3x2 matrix with the name planets1 whose content is the same as that shown on the 
data tab generated previously by using the import wizard for the planetsize.txt file.
 
 
 
 
dlmread
 
This function is similar to csvread but more flexible, allowing the delimiter to be specified by 
any character rather than restricting it to be a comma.  For example, suppose that the file planets2.
txt had the format
 
6371; 5.97
3390; 0.64
6052; 4.87
 
where values are separated by semi-colons.  The command
 
>> planets = dlmread('planets2.txt', ';')
 
would create that same 3x2 matrix with the name planets2.
 
 
load
 
This is similar to csvread and dlmread but the separators have to be blank spaces.  For example, 
if the file planets3.txt has the structure
 
6371 5.97
3390 0.64
6052 4.87
 
then the command
 
>> load planets3.txt
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would create the same 3x2 matrix with the name planets3. Note that the argument for the load 
command is not enclosed in quotes or parentheses.
 
 
fscanf
 
This is a lower level import function, equivalent to the C language function of the same name but 
with the important difference that the result is vectorized.  It requires extra manipulations of 
opening and closing the file, but is more versatile in allowing text and numbers to be read in 
together.  For example, if we want to import the data from our file planetsize.txt we could use the 
following sequence of commands to import the contents of the file in vectorized form
 
fid = fopen('planetsize.txt');
planetsize = fscanf(fid,'%c');
fclose(fid);
where the '%c' argument for fscanf is identical to the C language, i.e., parsing as character 
strings.  The variable planetsize is then actually an 80 element row vector of characters (including 
blank spaces, tabs, and linefeeds) which have numerical ASCII character code values.  
Characterized data values need to be converted to numbers before mathematical manipulations 
will make sense.  For example, we could convert the characters in the string representing the 
earth radius, i.e., elements 39 – 42, to numerical form using the str2num Matlab function:
 
>> earthradius = str2num(planetsize(39:42))
 
The variable earthradius will be in numerical form, ready for performing mathematical 
operations, e.g.,
 
>> earthvolume = (4/3)*pi*((earthradius)^3)
 
 
textread
 
The textread function is similar to the primitive fscanf but will allow data variables to be 
defined as part of the import process.   As an example, again suppose that the file planetsize.txt 
contains the information that we want to import into Matlab. We can specify the number of 
header lines to skip before reaching the actual data (one such line in this example), and the 
individual data formats for each column of data.  The file contains the character string planet 
names in the first column, the decimal integer planet radii in the second column and the floating 
point planet masses in the third column.  Thus, the command
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>> [planets, radii, masses] = textread ...
   ('planetsize.txt','%s %d %f','headerlines',1)
 
where ‘%s’ signifies string, ‘%d’ signifies decimal, and ‘%f’ signifies floating point in the format 
argument, will give the display
 
planets = 
        'Earth'
        'Mars'
        'Venus'
 
radii =
        6371
        3390
        6052
 
masses =
        5.9700
        0.6400
        4.8700
and add the vector variables planets, radii, and masses to the workspace.
 
M-file Scripts
 
If data are already present within a text file containing only legitimate Matlab command syntax, 
then that data can be imported by giving the file name an extension ".m" if not already present, 
and then typing that file name (without the ".m" extension) in the Matlab command window.  For 
example, an external M-file planetradii.txt containing
 
earthradius = 6371
marsradius = 3390
venusradius = 6052
 
can be re-named to planetradii.m and then used as a source to import these variables and their 
values using the command
 
>>  planetradii
 
 
Export Functions
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diary
 
The simplest way to export data to an external file is to make use of the diary function.  This is a 
utility for logging a transcript of the Matlab command line input and screen output.  The logging 
process starts subsequent to the command 
 
>> diary filename 
 
where “filename” is chosen, and terminates with the command  
 
>> diary off
 
thus creating an external file that can be edited with a text editor to remove extraneous material.  
For an example, let us create new variables using the data imported from the planetsize.txt file:
 
>> volumes = (4/3).*pi.*((radii).^3);
>> densities = (10^27).*masses./((10^15).*volumes);
>> planetinfo(:,1) = volumes;
>> planetinfo(:,2) = densities;
 
The variable planetinfo will then be a 3 x 2 matrix with column 1 containing planet volumes in 
cubic kilometers and column 2 containing planet densities in grams per cubic centimeter.  To 
export this information to an external file planets4.txt we first activate the diary, set the display 
format to exponential form, type in the name of the variable planetinfo, and turn off the diary:
 
>> diary planets4.txt
>> format short e
>> planetinfo
>> diary off
 
The external file planets4.txt then contains 
 
format short e
planetinfo
 
planetinfo =
  1.0832e+012  5.5114e+000
  1.6319e+011  3.9219e+000
  9.2851e+011  5.2450e+000
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diary off
 
The planets4.txt file can then be put into a text editor for deleting unwanted lines, adding column 
headers, etc.
 
 
dlmwrite
 
The dlmwrite function allows you to write external data files in which the delimiter can be 
specified.  Let us assume that we have the variables from the textread example above loaded into 
the workspace; that we have defined the vector variables volumes and densities as shown above; 
and that we want to write out a new file planets5.txt with the new volume and density data.   We 
create a local array planets5 in the Command Window by typing in the desired data, a column for 
each of the two vector variables
 
>> planets5(:,1) = volumes;
>> planets5(:,2) = densities;
 
 The command
 
dlmwrite('planets5.txt',planets5, ';')
 
requests that the contents of the array planets5 be written to an external file planets5.txt using a 
semicolon delimiter.  Thus the new external file planets5.txt will contain
 
1083206916845.75;5.5114
163187806143.123;3.9219
928507395798.201;5.245
 
 
 
save
 
This utility is a primitive function that will save an array in an external file with columns 
separated by blank space.   With no arguments at all, the save command will store the current 
values of all variables in a binary file matlab.mat from which they can be retrieved in a 
subsequent Matlab session.  Using the same array planets5 created above, the command
 
>> save planets5.txt planets5 -ascii
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will produce an external file planets5.txt whose content is
 
  1.0832069e+012  5.5114124e+000
  1.6318781e+011  3.9218617e+000
  9.2850740e+011  5.2449771e+000
 
Without an extension such as “.txt” and the flag “-ascii”, the default external file will be given a 
default extension “.mat” and will be in binary format.  
 
 
fprintf
 
This is another low level function that is equivalent to the C language function of the same name.  
It is useful for exporting information that contains both text and data in a specified format, using 
syntax similar to that of the C programming language.  As an example, suppose we want to 
export the newly computed planet volume and density values shown above into a file planetinfo.
txt that has the same layout as the imported file planetsize.txt.    For this purpose we need to 
create strings of 49 characters for each line in a new array, both the header line which identifies 
the data in each column and the three subsequent data lines themselves.  We will give the new 
4x49 array the arbitrary name outdata.  The header for the column of planet names, consisting of 
the first ten characters of each line, can be created by assignment
 
>> outdata(1,1:10) = 'Planet    '
 
and the headers for the variable columns, spanning 38 subsequent characters, can be generated by
 
>> outdata(1,11:50)='Volume (km^3)          Density(g/cc)    '
 
The subsequent data lines will have the planet names and variable values.  For these, the numeric 
values in the planetinfo variable need to be converted to text using the Matlab num2str utility.   
For example
 
 
 
 
>> outdata(2,1:10) = 'Earth     ' 
>> outdata(2,11:50) = num2str(planetinfo(1,:))
>> outdata(3,1:10) = 'Mars      '
>> outdata(3,11:50) = num2str(planetinfo(2,:))
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>> outdata(4,1:10) = 'Venus     '
>> outdata(4,11:50) = num2str(planetinfo(3,:))
 
We also need to create an end of line character for each line in the 51st position.  This is done 
using the Matlab sprintf command, which functions as a printing command in the same way as 
its namesake does in the C programming language  
 
>> outdata(1:4,51) = sprintf('\n')
 
where ‘\n’ is the notation for the end-of-line character. As an output format we want the text 
strings with a line feed in the display wherever there is an end-of-line character in the array.  We 
can create a format variable, for example outformat, which specifies the display characteristics by 
assigning it a string value with parsing instructions
 
>> outformat = '%s \n'
 
where ‘%s’ indicates a string and ‘\n’ indicates a linefeed at the end-of-line character.  The new 
file with the derived variable data can then be created with a sequence of two commands, the first 
opening a new file with fopen and assigning it a numerical file ID and the second printing the 
contents in the desired format with fprintf, both of which are analogous to their namesake 
commands in the C programming language.  In our example we created the output array by row 
whereas fprintf assembles by column.  Thus the array that we want exported is actually the 
transpose of that which we created, i.e., outdata'  (with the trailing single quote mark) rather than 
outdata itself.  In the Command Window we therefore execute the commands
 
>> fid = fopen('planetinfo.txt', 'w')
>> fprintf(fid,outformat,outdata') 
 
where the "w" is the permission argument of fopen signifying permission to create and write to 
the file.
 
 
M-Books
 
The M-Book feature is used to transfer data between Matlab and Microsoft Word, a commonly 
used word processing utility.  As an example, suppose that we want to export some information 
into a small Microsoft Word document with the name planetdata.doc. 
We would first need to set up the proper configuration, which can be done with the command
 
>> notebook('–setup')
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Subsequently the command
 
>> notebook planetdata.doc
 
opens up a Word document in a floating window into which you can copy and paste the desired 
information from the Matlab command window, as well as composing any annotation.   This also 
adds a "Notebook" pulldown menu to the Word navigation toolbar, from which cell operations 
can be performed.  
 

 
When finished, selecting File > Save from the navigation bar of the floating window will save its 
contents into a Word document with the chosen name, planetdata.doc in this instance.  This new 
file will be placed into the folder designated as the Current Directory.  Note that you can later 
import the information from the saved document by opening it from the Command Window
 

http://www.utexas.edu/its-archive/rc/tutorials/matlab/ (28 of 145)11.09.2007 07:54:15



Matlab Tutorial

>> open planetdata.doc
 
and evaluating cells in Word with Notebook >  Evaluate Cell. as has been done in the illustration 
above.  This will add the evaluated variables into the Matlab workspace.
 
 
 
Advanced Methods for Binary Information
 
In addition to the basic methods presented in this tutorial, there are several utilities available in 
Matlab for importing specialized types of binary files.  Examples are aviread for audio-video 
interleaved (AVI) files, imread for image files in common formats such as .jpg or .gif, and 
xlsread for Excel spreadsheets.
 
For example, the data from the Excel spreadsheet planets6.xls can be imported into the Matlab 
workspace with the command
 
>> xlsread planets6
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Part II: Computing and Programming
 

Section 5: Computational Procedures 
 

The fundamental concept to remember when doing computations with Matlab is that everything 
is actually a matrix, however it may be displayed.  Indeed, the name Matlab itself is a contraction 
of the words “MATrix LABoratory”.  Thus the input
 
>> a = 1
 
does not directly assign the integer 1 to the variable a, but rather assigns a 1x1 matrix whose first 
row, first column element is the integer 1.  Similarly, the input
 
>> b =  ’matlab’
 
does not directly assign that character string to the variable, but rather assigns a 1x6 matrix, i.e., a 
six element row vector of type text.  The elements are displayed as characters because of the text 
data type, but the underlying structure is a vector of integers representing the ASCII character 
code values for the letters, which becomes apparent if it is multiplied by the integer 1, e.g., 
 
>> c =  1.*’matlab’
 
c =
 
   109    97   116   108    97    98
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Logical expressions can be assigned to a variable, with a binary value specified by their truth or 
falsity, but the actual variable is again a 1x1 matrix whose element is 1 or 0 rather than the binary 
digit itself.  For example,
 
>> d = (1+1 = = 2)
 
creates a logical  1x1 matrix [1] with the property that (d + d) will produce the numeric 1x1 
matrix [2], while (d & d) will produce the logical 1x1  matrix  [1].
 
Special Built-in Constants
 
In addition to the default assignment for i and j as the complex-valued , Matlab has several 
other built-in constants, some of which can be overwritten by assignment, but which are then 
restorable to the original default with a clearing command.  Some commonly used ones with 
universal meaning are
 
 
 
pi        for the rational approximation of 
inf      for generic infinity (without regard to cardinality)
NaN   for numerically derived expression that is not a number, e.g., 
 
One particular built-in constant is a de facto variable that is constantly being overwritten:
 
ans   for the evaluation of the most recent input expression with no explicit assignment
 
Care needs to be taken that no variable is intentionally assigned the name ans  because that 
variable name can be reassigned a value without explicit instruction during the execution of a 
program.   Thus, though years is a commonly used variable name in computational problems, its 
French equivalent ans should be avoided.  Similar to this are random number “constants”, also de 
facto variables because the values are overwritten every time they are called:
 
rand    for a random number from a uniform distribution in [0,1]
randn  for a random number from a normal distribution with zero mean and unit variance
 
These random number constants are similar to the i and j used with complex numbers in terms of 
retaining their meaning,  They represent pseudo random numbers which are revalued sequentially 
from a starting seed, but once assigned specific values the built-in definitions are lost.  However, 
the built-in functionality can be restored with the commands clear rand and clear randn.
 

http://www.utexas.edu/its-archive/rc/tutorials/matlab/ (31 of 145)11.09.2007 07:54:15



Matlab Tutorial

There are also some built-in constants that are characteristic of the particular computer on which 
calculations are being performed, again susceptible to being overwritten, such as
 
realmin   for the smallest positive real number that can be used
realmax  for the largest positive real number that can be used
eps          for the smallest real positive number such that (1 + eps) differs from (1)
 
Some built-in "constants" are matrices constant by structure but variable in dimension:
 
zeros(n)  for an n x n matrix whose elements are all 0
ones(n)   for an n x n matrix whose elements are all 1
eye(n)     for an n x n matrix whose diagonal elements are 1 with all other elements 0
 
 
Special Built-in Functions
 
Matlab has very many named functions that come with the application.  As with variable names, 
function names are also case sensitive.  The pre-defined built-in functions usually have names 
whose alphabetic characters are all lower case.  There are too many to enumerate in a tutorial, but 
some that have substantial utility in computation and mathematical manipulation and which use 
standard nomenclature are the usual trigonometric functions and their inverses (angle values in 
radians)
 
sin, cos, tan, csc, sec, cot, asin, acos, atan, acsc, asec, acot ;
 
the hyperbolic trigonometric functions and their inverses (angle values in radians)
 
sinh, cosh, tanh, csch, sech, coth, asinh, acosh, atanh, acsch, asech, acoth ;
 
and the exponential and various base logarithms
 
exp                 exponential of the argument 
log                  natural logarithm of the argument
log2                base 2 logarithm of the argument
log10              base 10 logarithm of the argument
 
There are also several less commonly used built-in mathematical functions which can be very 
useful in particular circumstances such as various Bessel functions, gamma functions, beta 
functions,  error functions, elliptic functions,  Legendre function, Airy function, etc.  All of these 
built-in mathematical functions are, of course, algorithms to compute rational numerical 
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representation within word memory size, and thus do not produce exact values either for 
irrational numbers or for numbers whose decimal expansion does not terminate within machine 
limits.
 
In addition to these functions that do a numerical mapping, there are also built-in functions for 
characterizing an argument.  Functions for characterizing complex numbers, some of which also 
are applicable to ordinary real numbers, include
 
abs        for the absolute value
conj      for the complex conjugate
real       for the real part
imag     for the imaginary part
 
Similarly, there are built-in functions that characterize ordinary real numbers
 
factor   for producing a vector of prime number components
gcd       for greatest common divisor
lcm       for least common multiple
round   for closest integer
ceil        for closest integer of greater than or equal value
floor     for closest integer of lesser than or equal value
 
Matlab also has built-in functions to characterize vectors of elements
 
 
 
length      for the number of elements
min          for the minimum value among the elements
max         for the maximum value of among elements
mean       for the mean value of the elements
median   for the median value of the elements
std           for the standard deviation from the mean of element values
 
There are some built-in logical functions as well, valued as 1 when true and 0 when false:
 
isprime    for status of a number as prime
isreal       for status of a number as real
isfinite     for status of a number being finite
isinf         for status of a number being infinite
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Matlab also has several built-in functions for vectors and matrices in addition to those which are 
extensions of built-in functions for individual numerical matrix elements
 
size              for number of rows and columns
det               for determinant     
rank            for matrix rank    
inv               for inverse
trace            for sum of diagonal elements
transpose    for transposing rows and columns
ctranspose  for matrix complex conjugate transpose (adjoint)
eig               for column vector of eigenvalues
svd               for column vector of singular value decomposition 
fft                 for fast Fourier transform
ifft                for inverse fast Fourier transform
sqrtm          for matrix square root
expm           for matrix exponentiation
logm            for matrix logarithm
 
Compound Expressions and Operator Precedence
 
Users can construct their own functions by defining algorithms or expressions that combine 
simpler or built-in functions and constants; by producing composites from nesting of simpler 
functions; by scaling or mapping to a different domain, etc.; and by installing computational code 
as function m-files in the Matlab search path.  Some simple representative examples, presented 
here by definition with generic arguments x and y are:
 
e = x + log(x)
f = cos(sin(tan(x + sqrt(y))))
g =  atan(y/x)
h = sqrt(x^2 + y^2)
 
Similarly, manipulations can be done to create compound expressions involving matrices and 
vectors. For simple examples, suppose M and N are generic square matrices of the same 
dimension.  Some sample user-created composite expressions are:
 
P = M^2 + 2.*(M*N) + N^2
Q = inv(transpose(sqrtm(M) + logm(N)))
R =  fft(N\M)./((length(M))*(rank(N)))
 
When the construction of composite expressions gets complicated the order and precedence of 
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operations becomes important.  In Matlab, expressions are evaluated first with grouping of 
parentheses, innermost first sequentially to outermost whenever there is nesting.  Evaluation then 
takes place from left to right sequentially at each level of operator precedence.  This is of 
importance when binary operations are not commutative.  The precedence order is { .^, ^}  > 
{unary +-} > { .*, *, ./, /, \ } > { + , - } but the sequence of operations can be specified explicitly  
by parenthesis grouping.  As an example consider the following value assignment with no 
grouping
 
>> k = 1-2^3/4+5*6
 
Matlab would first go from left to right in the right hand side expression looking for a right (i.e., 
closing) parenthesis. Finding none, it would then search from left to right looking for 
exponentiation operators.  There is one present, linking the digit 2 with the digit 3, so the first 
step in constructing a value would be to assign the segment 2^3 with its mathematical value of 8. 
That exhausts the top level of precedence, so the procedure is recursively repeated left to right at 
each level of lower precedence giving a sequence
 
k = 1-8/4+5*6
k = 1-2+5*6
k = 1-2+30
k = -1+30
k = 29
 
But what if there were some grouping parameters in the expression?  Using the same sequence of 
elements in k suppose we have the value assignment
 
>> m = (1-2)^(3/(4+5)*6)
 
Now when Matlab initially goes from left to right looking for a right parenthesis it will find one 
immediately following the element 2. So it then immediately backtracks to find the closest left 
parenthesis and does a sub-evaluation of the elements within that set of grouping parentheses.  In 
this case it finds only one operation, i.e., (1-2), and evaluates it to (-1).  Then the search continues 
to the right until the next right parenthesis is found.  This continues until all groupings have been 
collapsed to single elements, after which the recursive left to right processing based on operator 
precedence continues.  In this particular example, the result would be
 
m = (-1)^(3/(4+5)*6)
m = (-1)^(3/9*6)
m = (-1)^(0.33333…*6)
m = (-1)^(2)
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m = 1
 
Logical operators also have a precedence order:  { ~ } > { & } > { | }.
 
Commutivity of Operations and Finite Decimal Expansion Approximations
 
By definition matrix multiplication is non-commutative, e.g.,  M*N is different from N*M, so 
many expressions involving matrix operations will also be dependent on positioning relative to 
operators.  Addition and multiplication operations on scalars should be commutative, but 
computational procedures involving round off or irrational number representation by finite 
decimal expansion can occasionally lead to unexpected results, for example: 
 
>> t  =  0.4 + 0.1 - 0.5    assigns a value                     0   to the variable t
>> u  =  0.4 - 0.5 + 0.1    assigns a value   2.7756e-017   to the variable u
 
The same problem can also lead to occasional surprises in the value assignment for logical 
variables, for example
 
>> v = (sin(2*pi) = = sin(4*pi))  
 
assigns a value 0 to the variable v (logical false), giving the impression that the sine function does 
not have a period of .
 
Computing with matrices and vectors
 
The matrix is the fundamental object in Matlab.  Generically a matrix is an n row by m column 
array of numbers or objects corresponding to numbers.  When n is 1 the matrix is a row vector, 
when m is 1 the matrix is a column vector, and when both n and m are 1 the 1 x 1 matrix 
corresponds to a scalar.  Development of an end user interface for easy access of subroutines used 
in numerical computations with matrices, particularly in the context of linear algebra, was the 
original concept behind the development of Matlab. Thus, calculations involving matrices are 
really well-suited for the Matlab application.  Matrix calculations also can represent an efficiency 
in doing simultaneous manipulations, i.e., vectorized calculations.  This can eliminate the need to 
cycle through nested loops of serial commands.  As an example, let’s compare a matrix 
computation with an equivalent calculation using scalars.  Suppose we have a matrix  
 
            
 
The vectorized matrix procedure
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>> power2 = power1.^2
 
is more efficient than is the scalar procedure:
 
>> for nrow=1:3
      for mcolumn = 1:3
         power2(nrow, mcolumn) = (power1(nrow, mcolumn)).^2
      end
   end
 
 
Simultaneous linear equations
 
One of the most powerful and commonly used matrix calculation procedures involves the 
solution of a system of simultaneous linear equations.  As an illustrative example we will 
consider a very elementary case: the grocery bill for customers Abe, Ben, and Cal who purchase 
various numbers of apples, bananas, and cherries:
 

Customer  Apples   Bananas   Cherries    Cost
Abe 1 3 2 0.41
Ben 3 2 1 0.37
Cal 2 1 3 0.36

 
From this data we want to know the costs of an individual apple, an individual banana, and an 
individual cherry.   Using Matlab we can create a count matrix A that has the quantities 
purchased arranged with  the rows representing the customers and the columns representing the 
types of fruit, i.e.,
 
 
and a column vector b representing the total cost for each customer, i.e.,
 
 
If we then create a column vector x representing the individual cost of an apple, a banana, and a 
cherry in descending order, i.e.,
 
 
then the system can be stated as the matrix equation
 
A*x  =  b
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Multiplying each side from the left by the inverse of the matrix A will give
 
((inv(A))*A)*x  = (inv(A))*b
 
But a matrix multiplied by its inverse from the right or left gives an identity matrix I with ones on 
the diagonal and zeros elsewhere, so that 
 
((inv(A))*A)*x  =  I*x  =  x
 
Thus, the simple solution using Matlab is the command
 
>> x = (inv(A))*b
 
which will produce the vector with the unit costs of each individual fruit:
 
          
Thus the grocer charges 5 cents for an apple, 8 cents for a banana, and 6 cents for a cherry.
 
Eigenvectors and Eigenvalues
 
Because Matlab was originally developed primarily for linear algebra computations, it is 
particularly suited for obtaining eigenvectors and eigenvalues of square matrices with non-zero 
determinants.  The determinant of a square n x n matrix A from which a constant   has been 
subtracted from the diagonal elements will be a polynomial of degree n in  and the roots of that 
polynomial are the eigenvalues of the original square matrix A.  The eigenvectors of such a 
matrix will consist of n column vectors, with n elements each, which can form an n by n 
eigenvector matrix V.  If the n eigenvalues are inserted along the diagonal of an n by n matrix of 
zeros to form the diagonal eigenvalue matrix D, then original matrix A corresponds to  
 
>> A = V*D*(inv(V))
 
After left multiplication by inv(V) and right multiplication by V on each side of the equation it 
can be seen that the diagonal matrix D is equivalent to  inv(V)*A* V.  The Matlab syntax for 
obtaining these entities is
 
>> [V,D] = eig(A)
 
where eigenvectors are assembled as column vectors in the matrix V and eigenvalues are placed 
on a diagonal of matrix D with zeros elsewhere.  When there is only a single variable assignment, 
the eig function returns a column vector of the eigenvalues.  As an example, let
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Then the command line instruction d = eig(A) returns 
 
d =  
       -1
         6
 
whereas the command line instruction [V,D] = eig(A) returns
 
V =
 
   -0.7071   -0.3714
    0.7071   -0.9285
 
 
D =
 
    -1     0
     0     6
 
Roots of polynomials and zeros of functions
 
Another computational procedure that is commonly used in Matlab is that of finding the roots of 
polynomials, or in the case of non-polynomial functions, argument values which produce 
functional values equal to zero.  For example the trivial polynomial x^2 – 4 has zeros at x =  – 2 
and at  x = +2, which are also called roots since the function is a polynomial.  Similarly the 
function sin( x) has zeroes at x = 0, x = ± 1, x = ± 2, etc.
Although the roots of the trivial polynomial can be evaluated by inspection, it can also be done 
using Matlab if we form a row vector p with coefficients of powers of x in descending order:   p   
=  [ 1   0  – 4 ].   The command line instruction will produce a column vector with the roots:
 
 
 
>> proots = roots(p) 
 
proots =
 
    2.0000
   -2.0000
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The polynomials can be much more elaborate, and roots are not always real.  For example 
consider the polynomial   3*x^5 – 10*x^4 + 2*x^3 – 7*x^2 + 4*x – 8, which can be represented 
in Matlab as
 
q = [ 3  -10  2  -7  4  -8 ]   
 
The roots are easily found and displayed as a column vector with the command line instruction
 
>> qroots = roots(q)
 
qroots =
 
   3.3292          
  -0.5335 + 0.8285i
  -0.5335 - 0.8285i
   0.5356 + 0.7335i
   0.5356 - 0.7335i
 
The inverse of the roots function is the poly function, which will produce a row vector of 
polynomial coefficients in descending power order that describe a polynomial function whose 
roots are given by the input data vector.  This is arbitrary up to a multiplicative factor, so the 
answer given is with scaling such that the coefficient of the highest power is set equal to 1.  Thus, 
using the variables defined here,
 
>> qcoeffs  = poly(qroots) 
 
will regenerate the values in the vector q, scaled by since the lead coefficient was 3.
Argument values that produce functional values equal to zero in non-polynomial functions, built-
in or user-defined, can be obtained in Matlab by using the fzero command.  This is a search 
procedure however, and a starting point or an interval must be specified.  Whenever a zero 
functional value is detected the corresponding argument is returned as the answer with no further 
searching.  Thus, for multiple solutions only the first found from the search start value is 
returned, in the form of a scalar.  The target function name is preceded by an @ symbol and a 
start point or interval has to be specified.  Thus, using the trivial example above of sin(x), where 
we know the zeros by inspection, a particular solution near  can be obtained with Matlab by 
giving the command line instruction
 
>> sinzero = fzero(@sin, [0.9*pi  1.1*pi])
 
sinzero =
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    3.1416
 
which calculates the closest answer as 3.1416, approximately , as expected.
 
Poles, residues, and partial fraction expansion
 
The residue function in Matlab is a bit unusual in that it is its own inverse, with the 
computational direction determined by the number of input and output parameters.  Its utility is to 
determine the residues, poles, and direct truncated whole polynomial obtained with the ratio of 
two standard polynomials when that ratio does not reduce to a third standard polynomial, or vice 
versa.  When there are three output variables and two argument vectors, the arguments are taken 
to be the coefficients of a numerator polynomial and the coefficients of a denominator 
polynomial. The output vectors are the residue coefficients for the poles, the pole locations in the 
complex plane, and descending coefficients of the direct whole polynomial part of the expansion.  
As an example 
 
>> pn = [1 -8 26 -50 48];
>> pd = [1 -9 26 -24];
>> [r,p,k] = residue(pn,pd)
 
r =
    4.0000
    3.0000
    2.0000
p =
    4.0000
    3.0000
    2.0000
k =
     1     1
 
 
This is equivalent to the expression
 

 = 
 
Using the residue function in reverse, if we know the partial fraction expansion vectors, we can 
then reconstruct the polynomials whose ratio generated it.  In this case the residue coefficient 
vector, the pole location vector, and the direct whole polynomial vector are given as arguments 
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with the output being the corresponding numerator and denominator polynomials which form an 
equivalent ratio:
 
>> [qn,qd] = residue(r,p,k)
 
qn =
    1.0000   -8.0000   26.0000  -50.0000   48.0000
 
qd =
    1.0000   -9.0000   26.0000  -24.0000
 
The residue function can also be used when the polynomial ratio has poles with multiplicity or 
order greater than one. Typing help residue at a command line prompt will give details 
concerning those special circumstances.
 
 
Convolution and deconvolution
 
Many engineering applications involving input and output functions to and from a system use 
numerical convolution and deconvolution to describe each in terms of a system transfer function.  
These numerical processes correspond to a process of polynomial multiplication and its inverse.  
If an input function and a transfer function can be represented as vectors of lengths n and m then 
the output can be expressed as a convolution vector whose length is (n + m –1).  This is similar to 
polynomial multiplication.  Consider for example the polynomials y = (ax + b) and z = (cx + d), 
both of which have a coefficient vector length of 2, i.e., [ a b] and [ c d ].  The multiplication of 
these two polynomials yields (acx^2 + (ad + bc)*x + bd), which has a vector length of (2+2-1) = 
3, i.e.,  [ (ac)  (ad+bc) (bd) ].  In Matlab, such convolution can be accomplished by using the 
conv function on the two vectors.  The command line instruction in Matlab to find the 
convolution would require numerical values be assigned to the coefficients a, b, c, and d.  Using 
these input vectors
 
>> x = conv(y,z) 
 
would generate the convolution vector x.  The deconv function is merely the inverse.
For example, if the output vector x and the transfer function vector z were known but the input 
vector y unknown, then the deconvolution 
 
>> y = deconv(x,z) 
 
would reconstruct the values of y as a deconvolution vector having the same sequence of 
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elements that produced the known output vector.
 
 
Fast Fourier and Inverse Fourier Transforms
 
The process of convolution in one domain corresponds to a process of multiplication in that 
domain's Fourier transform space.  This can simplify calculations of complicated convolution 
problems and is commonly used in engineering and signal processing.  Once the calculations 
have been performed, the results can be recast in the original domain using an inverse Fourier 
transform.  Matlab provides functions for doing such transforms.
The function fft, and its 2-D equivalent fft2, transform a vector or the columns of a matrix to a 
Fourier transform domain.  Similarly, the inverse functions ifft and ifft2, transform a vector or the 
columns of a matrix to the inverse Fourier transform domain.  As a trivial example consider the 
vector f = [ 1 2 3 ] and its transformation to a vector g in Fourier transform space
 
>> g = fft(f)
 
g =
 
   6.0000     -1.5000 + 0.8660i      -1.5000 - 0.8660i
 
 
then reversion to a vector h in the original space which reconstitutes the original f:
 
h = ifft(g)
 
h =
 
     1     2     3    
 
 
Numerical Differentiation and Integration
 
Matlab has a few functions that can be used in obtaining finite approximations for differentiation 
and for numerical integration by quadrature.  Numerical differentiation methods are difficult 
because vector or matrix elements cannot always be expanded in resolution to approximate 
limiting ratio values.  However, if a function or data vector can be fit well by an approximating 
polynomial, then the polyder function can be used to get a derivative of that approximate 
function.  This function considers an n element argument vector to represent the n coefficients of 
a polynomial of order (n-1) in descending order, i.e., the last element is the zero order 
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coefficient.  For example, suppose we have an independent variable vector x = [ 1 2 3 4 5 ] and 
suppose we have a dependent functional vector y = [0  -3  -4  -3  0 ].  We can fit this data exactly 
to a fourth degree polynomial with 5 coefficients.  The Matlab function polyfit is used and we 
choose to store the 
coefficients in a vector z:
 
>> z = polyfit(x,y,4)
 
z =
 
   -0.0000    0.0000    1.0000   -6.0000    5.0000
 
The coefficients of the derivative of the approximating (and in this case exact) polynomial 
representation are then obtained with the polyder function, which we will store in a vector 
designated w.  Because the zero order polynomial term is a constant whose derivative is 
identically zero, that final element is omitted in the vector of derivative coefficients generated by 
polyder.  Note that this vector is a vector of coefficients and can be used to obtain numerical 
values for the “derivative”  at any particular value of the independent variable x.
 
>> w = polyder(z)
 
w =
 
   -0.0000    0.0000    2.0000   -6.0000
 
The diff function in Matlab uses the limiting approximation of the ratio of function change to 
argument change to obtain a numerical derivative. This can produce very crude results, but can be 
somewhat useful if the independent variable values are regularly spaced with high resolution and 
the functional value changes at that resolution are relatively smooth.  The syntax for this 
procedure, using the same example data as were used illustrating the polyder method but this 
time storing in a vector v, is:
 
>> v = diff(y)./diff(x)
 
v =
 
    -3    -1     1     3
 
With this method, the “derivative” values themselves are the elements of the vector, rather than 
coefficients.  Note that, because of the difference method used, the vector of derivative values is 
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one element shorter than the original data vectors.
 
Numerical integration can be done with analogous methods.  As an illustration, let’s consider the 
integration of the same dependent function variable vector y from the numerical differentiation 
example above over the range of the independent vector x, also from that prior example.  We can 
construct a formula-based integration vector using the polyint function on the polynomial 
approximation vector z, and we shall store it in a vector u:
 
>> u =  polyint(z, 0)
 
u =
 
   -0.0000    0.0000    0.3333   -3.0000    5.0000       
0         
 
The second argument of the polyint function is a constant of integration and will appear as the 
final element in the quadrature vector if it is specified.   With no second argument a value of zero 
is assumed, so it was unnecessary here but was used anyway to illustrate the two-argument 
syntax.   The elements computed in the vector u are coefficients of a polynomial, in descending 
order, from which polynomial numerical values can be computed for any particular independent 
variable value.
 
Another method for integration is numerical quadrature with Matlab’s quad function, which uses 
an adaptive Simpson’s Rule algorithm. The arguments for this function are a function name or 
definition in terms of an independent variable, the lower limit of integration, and the upper limit 
of integration.  Thus, to use the same example, we would need to create a function m-file, say 
yvalues.f, to define the function element by element from data vectors. Alternatively if an explicit 
relationship can be given, such as the exact polynomial found in this case with polyfit, then the 
functional expression can be given in single quotes as the argument.  This latter method will be 
shown here since creating function m-files are not covered until the following section.  The range 
of x in the example is 1 to 5.  The polynomial coefficient vector for the curve fitting had third and 
fourth order coefficients of zero so that the function value at each value of x is given by x.^2 – 
6*x  + 5. Therefore, if we want to store the value of the numerical integration in 
the variable t, we can use the command
 
>> t = quad('x.^2 - 6*x + 5', 1, 5)
 
t =
 
  -10.6667
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Compare that result with the result derived from the u vector, i.e.,
 
0.3333*(5^3 – 1^3)  -3*(5^2 – 1^2) + 5(5^1 – 1^1) =  -10.6708
 
 
Numerical solution of differential equations
 
Matlab has several solver functions for handling ordinary differential equations (ODEs), and a 
few functions for handling initial value problems (IVPs) and boundary value problems (BVPs) 
are also available.  Additionally there is a specialized PDE Toolbox with functions for use with 
partial differential equations, but this Toolbox is not included in the Matlab licenses issued to 
ITS.  However, there is one function included in the standard distribution of Matlab 7 for use in 
cases of PDEs that are parabolic or elliptic with two dependent variables.  In general the syntax 
for using solvers is
 
>> [x,y] = solver(@func,[xinitial xfinal], y0, {options})
 
This assumes that a differential equation of order n is recast as a system of n first order 
differential equations of n variables and that it is described in a function m-file func where the 
independent variable vector x spans the range from xinitial to xfinal and where dependent 
variable y to be solved has a known initial value vector y0.  The independent variable vector x is 
uniformly spaced and is generated in response to solution iterations. Elements of the vector y are 
the solutions calculated for each value of the independent variable x.  The most commonly used 
ODE solvers for non-stiff systems are ode45 and ode23, both of which use a Runge-Kutta type 
method.  The solvers ode15s and ode23s are commonly used for stiff equations.  For boundary 
value problems, the general release of Matlab 7 has a solver bvp4c and for parabolic and elliptic 
PDEs the solver pdepe.
 
 
 

Section 6: Programming
 
Matlab has its own programming language, also known by the name Matlab, which is structured 
very much like most programming languages.  Because its origin involved interfacing with many 
of the original linear algebra subroutines written in FORTRAN, Matlab has roots there.  But there 
is also much similarity with C due to later development of graphics functionality and the desktop 
GUI.  The Matlab programming language is thus not particularly difficult or obscure, and the 
primary task in becoming adept at using it involves learning the various notations and syntax 
rules.
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Using the Editor
 
Matlab has the functionality of incorporating user-created files external to the Command 
Window.  These files need to be placed in a folder or directory defined in the pathway and should 
consist of a series of valid Matlab commands.  These are thus equivalent to macros or subroutines 
in other programming languages, and are called m-files.  They should have an extension of a 
period and a lower case m so that they can be recognized as Matlab text files.  The Matlab 7 GUI 
has a text editor interface that allows users to create m-files within the Matlab application.  As 
was mentioned in Section 3 above, it is launched from the navigation toolbar with File -> New -> 
M-file which opens up a new floating window ready for code text input.  This editing window has 
its own toolbar with conventional Windows type pull down menus and button icons.  Lines are 
numbered outside the text area for convenient referencing when debugging or inserting break, 
pause or flagging points.  This editor tool is very convenient, with color coding and indenting 
features that aid in construction, but m-files can also be created as plain ASCII text in other text 
editors such as MS Word or Note Pad.
 
 
Types and Structures of M-files
 
There are two main types of m-files which are very similar to each other: script files that act as 
command sequence macros with no parameter passing; and function files that also act as 
command sequence macros but which accept parameters by value and return a computed number, 
vector, or matrix assigned by the calling program.  M-file scripts have no formal structure other 
than consisting of a sequence of valid Matlab command line input.  After saving an m-file, which 
can be done from the File pull down menu of the Editor Window, any subsequent command line 
reference to it will result in the execution of its contents.  This applies both to input from a 
Command Window prompt and to any call from within another m-file.
 
A function m-file is similar except that the first command line should have the form
 
function [ var1 var2 {…} ] = functionname(arg1, arg2, {…})
 
and the returned information should assign the computed functional values to var1, var2, etc., 
obtained with the function computational algorithm.  A trivial example:
 

function f =  doubleval(x)
f = 2*x;
 

which creates a function that doubles the value of the input as the return value.  If you save this 
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code with a name such as doubleval.m, any subsequent call to doubleval from the Command 
Window prompt or from another script will return a value twice as large.  
 

 
 
The Shortcut Utility   

A Matlab shortcut is an easy way to run a group of Matlab commands that are used regularly, similar to a 
macro, but without the formality of having them incorporated as a script within the Matlab path.  Shortcuts 
can be created, run, and organized from the Start > Shortcuts menu or from the desktop Shortcuts 
toolbar.  From the Start button, select Shortcuts > New Shortcut.  The Shortcut Editor dialog box appears. 
Create the shortcut by completing the dialog box using these steps:

1.  Provide a shortcut name in the Label field to identify it
2.  Put the group of command statements in the Callback field. They can be entered directly 

from keyboard typing, copied and pasted, or dragged via a desktop tool. If imported, edit 
the statements as needed. The field uses the Editor/Debugger preferences for key bindings, 
colors, and fonts, so the Callback field will have an appearance similar to an m-file.  Note 
that if you copy the statements from the Command Window, the prompts at the beginning 
of a line appear in the shortcut, but Matlab removes these when the shortcut is saved. 

3.  Assign a category, which is like a directory, to be used for organizing shortcuts. To add the 
shortcut to the shortcuts toolbar, select the Toolbar Shortcuts category. 

4.  The default shortcuts icon is , but you may also select your own. 
5.  Click Save. 

 
Suppose that the following group of commands is desired for a shortcut
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            clear;
            format long e;
            disp('Memory has been cleared');
 
The shortcut window would then be constructed something like the following

The new shortcut will be added to the Shortcuts entry in the Matlab Start button, and to the 
Shortcuts toolbar, if that category has been selected.  Once created, a shortcut can then be run by 
selecting it from its category in the Matlab Start button. 

An alternative to creating and running shortcuts via the Start button is to use the Shortcuts 
toolbar. To show or hide the shortcuts toolbar, toggle the Desktop > Shortcuts Toolbar menu 
item. To create and run shortcuts via the desktop Shortcuts toolbar, go through a similar 
procedure:

1.      Select statements from the Command History window, the Command Window, or 
an m-file. 

2.      Drag the selected group of commands to the desktop Shortcuts toolbar and the 
Shortcut Editor dialog box will appear.  Here the Category field needs to be retained as 
Toolbar Shortcuts so that the shortcut will appear on the toolbar.

3.      Choose a Label, select an Icon, and click the Save button.  The shortcut icon and 
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label will then appear on the toolbar.

 

Publishing to HTML

When an m-file script is written, Matlab allows you to use its cell features to publish them in a 
presentation format, such as HTML. Not only can the code itself be presented, but also 
commentary on the code and results from running the file can be displayed.  This works only for 
script m-files, not for function m-files.

This is the overall process of publishing to HTML:

1.  In the MATLAB Editor/Debugger, enable cell mode. Select Cell > Enable Cell Mode. 
Items in the Cell menu become selectable and the cell toolbar appears. 

2.  Define the boundaries of the cells in an m-file script using cell features.  A cell is just a 
defined contiguous section of code.  Many m-file scripts consist of multiple sections and 
often it is necessary to focus on just one section at a time. M-file cells facilitate this 
process.  A cell can be created by positioning the cursor just above the line where the cell 
is to begin and then selecting Cell > Insert Cell Divider.  A line consisting of two percent 
signs (%%) will be inserted, indicating the start of the cell.  An identifier, called the cell 
title, can be appended by entering a blank space followed by a text string on the same line.  
All subsequent lines of code will belong to the cell until another cell start (line beginning 
with %%) occurs.

3.  Select File > Publish To HTML

An example can be seen within the Matlab Help utility by selecting Help > Matlab Help and then 
navigating to MATLAB > Desktop Tools and Development Environment > Publishing Results > 
Publishing to HTML, XML, LaTeX, Word, and PowerPoint Using Cells > Example of Publishing Without 
Text Markup.  This example is a simple sine wave m-file with two cells. The first cell creates the 
basic results, while the second labels the plot.

 
Internal Documentation
 
Matlab m-files can be annotated with internal documentation that is ignored by the command 
interpreter.  Any part of a command line, at a command window prompt or within m-file code, 
following a percent sign, i.e. %, that is not enclosed in quotes is considered as documentation and 
does not get processed.  The % delimiter can be anywhere on a line.  For example, compare the 
following command line instructions:
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>> u = 5% + 1%
 
u =
 
     5
 
 
>> v = '5% + 1%'
 
v =
 
5% + 1%
 
For an illustration of internal documentation, here is the display of an annotated function m-file, 
tripleval.m, which returns a value three times that of the input:
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Passing variables by name and value
 
If a script m-file is called from a Command Window prompt or by another script, then it is 
processed as a sequence of commands just as if each line had executed individually or had been 
incorporated as individual lines of the calling m-file.  Thus, all variables created and values 
assigned to them become a part of the workspace and are recognized by any subsequent 
reference.  On the other hand, function m-files have local variables by default.  Only the values 
specified as function components are returned.  However, a variable created within a function m-
file can be declared global before assigning a value.  If this is done then the next subsequent use 
of that variable name in another function m-file in which it has also been declared as global will 
start with the value already established.  Every function that is invoked will have its own 
workspace, but global variables can be shared.
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Also, function m-files may themselves contain functions, appended as subfunctions, which are 
constructed with the same structure as a regular function but with a return line indicating the 
end.  Subfunctions within each level can also share global variables and can include their own 
subfunctions.  As an illustration consider the following function m-file
 

 
 
 
The function xseven has two subfunctions, xfour and xthree.  The subfunctions xfour and xthree 
share a global variable xone, the subfunction xfour calls the same level subfunction xthree, and 
the subfunction xthree has its own local subfunction xtwo.
 
Using the function xseven is a very contorted way of multiplying a number by seven, but it 
illustrates function and subfunction architecture.  In the Workspace Window notice that a variable 
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generated within a function, e.g., xone, does not get carried over.
 

 
 
 
Function evaluation and function handles
 
Once a Matlab function m-file has been constructed, named, and placed in the search path, it can 
be used in several ways.  Let’s consider the example that we have already constructed and named 
xseven.m.  The most direct usage is to assign some variable the value of the function at a given 
argument, e.g.,
 
y(1) = xseven(5)
 
would assign a value of 35 to the variable y, whether interactively from a command line prompt 
or as a line of code in a script m-file.  Alternatively, there is a command eval in Matlab which 
will evaluate a character string as a line of code.  Thus, we get the same result if we use the 
command
 
y(2) = eval('xseven(5)')
 
However, this is not too efficient, as the entire Matlab interpreter is loaded for processing eval.  
For function evaluations the command feval, which is able to load only what is needed, can be 
used for greater efficiency.  This command takes as arguments a function name, followed by that 
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function’s arguments.  The function’s arguments can be by value or by variable name if a value 
has already been assigned.  As an example, suppose that we already have a variable z assigned 
the value 5 in the workspace.  Then an equivalent assignment for y can be obtained with
 
y(3) = feval('xseven', z)
 
Another feature of Matlab is the function handle data type.  This provides a means of speeding up 
execution by passing essential information about the function through a function handle, 
referenced with the syntax @function_name.  The handle can be assigned to a variable name, 
which in turn can replace the character string in the arguments of feval.  If we assign @xseven to 
a function handle variable, say 
 
x7handle = @xseven
 
then yet another, faster method of assigning the variable y above would be
 
y(4)  = feval(x7handle,z)
 
The results of all these methods, which have been stored in the vector y, are identical and have 
the value 35, i.e., the argument 5 operated on by the function xseven  -- which in a roundabout 
way calculates a multiplication by seven.
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Function recursion
 
A function value can also be passed back to itself through recursion.  A simple example is a 
function that computes a triangular number (sum of all integers less than or equal to the 
argument). In this function script notice that the function triangular calls itself:
 

function f = triangular(n)
 

% finds the sum of all integers from 1 through n
 
t = n;
if n > 1
    t = t + triangular(n-1); 
end;
f = t;

Flow control
 
In Matlab, flow control procedures, as well as syntax, are very similar to procedures in many 
other programming environments.  The for and while commands are constructs for executing a 
block of commands multiple times until a specified incrementing index value is reached or a 
logical termination condition is met. The finish of a repeating block of commands must be 
specified with an end statement. The general format is thus
 

for {index} = {firstvalue}:{lastvalue}
{command1; command2; ...}
end;
 
while {logical condition}
{command1; command2; ...}
end;
 

Just as in other programming environments, the for and while loops can have layers of nesting.  
As an example let’s look at a script for finding the number of seconds in a week, with emphasis 
on illustrating loops and nesting rather than efficiency:
 

% find the number of seconds in a week
total   =  0;      % start with none yet counted
for  m = 1:7       % consider every day in a week
    for  n = 1:24  % consider every hour in a day
        minval = 1;  % start minutes counter
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         while (minval <= 60)  
             secval = 1;  % start seconds counter
             while (secval <= 60)  
                 total = total + 1;  % increment total
                 secval = secval + 1;% increment secs
             end;
             minval = minval + 1;    % increment mins
         end;
     end;
 end;
weeksecond = total

 
Matlab also has the capability of logical contingency flow control with the if and switch 
commands.  The general construction of an if command is
 

if {logical condition}
   {command1; command2; ...}
    elseif {logical condition}
        {command1; command2; ...}
      .
      .
      .
    elseif {logical condition}
        {command1; command2; ...}
    else 
        {command1; command2; ...}
end
 

The blocks of commands are executed if the specified logical condition is true and an optional 
block of commands following else is executed if none of the preceding logical conditions are 
true.  The elseif segment can be expanded to include multiple logical conditions and command 
blocks, but only the block following the first logically true condition will be executed.  
 
The switch command has a similar function but flow is controlled by the current value of a 
specified expression.  The general structure is
 

switch {expression}
     case {value1}
          {command1; command2; ...}
     case {value2}
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          {command1; command2; ...}
     otherwise
          {command1; command2; ...}
end

 
The command block executed is that following the case value which corresponds to the value of 
the specified expression.  An optional otherwise command block can be included to cover 
expression values which are not enumerated in the cases.
 
As an example of using if and switch flow control, consider a script that determines the number 
of non-primes, primes, and twin primes (incrementing by 2 gives another prime) in a particular 
range of integers, for example between 1001 and 2000:
 

 
% find prime status of integers in a range
nontwins   =  0;    % start with none yet counted
twins = 0;          % start with none yet counted
nonprimes = 0;      % start with none yet counted
for  n = 1001:2000   % test all numbers in the range
    if isprime(n)
        switch isprime(n+2)
        case 1
            twins = twins + 1;        % increment  
        otherwise
            nontwins = nontwins + 1;  % increment 
        end;
    else
        nonprimes = nonprimes + 1;    % increment
    end;
end;
notprime = nonprimes
prime = nontwins + twins
twinprime = twins

 
 

String evaluation and manipulation
 
Although character strings are stored as vectors of ASCII character code integers within Matlab, 
they can be evaluated and manipulated in certain circumstances.  If a string contains text that 
represents a valid Matlab command or expression, then the eval command can process the string 

http://www.utexas.edu/its-archive/rc/tutorials/matlab/ (58 of 145)11.09.2007 07:54:15



Matlab Tutorial

as if it were command line input.  Similarly, if a string consists of the name of a defined or built-
in function, then the feval command specifying the function name and its input arguments can be 
used to generate a value.  As an illustration consider the following script that computes the 
integer within a given range that has the largest positive difference between its sine and cosine:
 

% maximum difference in sin vs cos in integer range
maxnum = 1; % initialize with first argument
maxdiff(1) = sin(1) - cos(1); % initialize difference
x = 'sin(n) - cos(n)'; % make a string function
for n = 2:1000         % select integer range
    y(n) = eval(x);    % evaluate the string
    maxdiff(n) = feval('max',y(1:n)); % update maximum
    if (y(n)>maxdiff(n-1))
        maxnum = n;    % update the argument if needed
    end;
end;
maxnum            % integer maximizing (sin - cos)
maxdiff = feval('max',y) % difference maximum
 

In this particular example the result will be the integer that most closely approximates a value of
, which, for the selected range, turns out to be 882, or about . There are 

also special built-in functions for evaluating and manipulating strings which are the text 
equivalent of integers, numbers, or even matrices.  All these require that any arguments which are 
not decimal-based integers or numbers be in a character string format (enclosed within single 
quotes).  This class of functions includes
 
str2num   and  num2str           [converting from strings to numbers and vice versa]
int2str                                      [converting integers to character strings]
hex2dec  and  dec2hex            [converting hexadecimal strings to integers and vice versa]
bin2dec   and  dec2bin            [converting binary strings to integers and vice versa]
base2dec and dec2base           [converting  non-decimal strings to integers and vice versa]
 
 
The general syntax used with these functions is
 
stringvalue =  number2string(number)
numbervalue = string2number(string)
 
As an example of the use of these commands we can construct a function for adding hexadecimal 
numbers, a feature which is not a built-in Matlab utility.  Here is one way to do this, where the 
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input is two hexadecimal character strings:
 
function f = hexadd(hex1,hex2)

% Add 2 hexadecimals represented by text strings
newhex = dec2hex(hex2dec(hex1) + hex2dec(hex2));
f = newhex;

 
Note that the output is also a hexadecimal character string:
 

 
 
 
Keyboard input
 
Matlab allows the programmer to include interactive input from the keyboard with the input 
command.  The command incorporates a prompt in the Command Window so that the user 
knows that an input is waiting.   A variable is assigned the value of the user’s input according to 
the syntax of the input command’s argument.  The syntax for the input command argument is a 
character string for prompting the user, enclosed in single quotes, followed by a lower case s in 
single quotes if the input is to be considered a string rather than a number or matrix.  This is a 
common way to allow a user to specify a starting guess in an optimization script or to specify a 
cutoff for an infinite series computation or iterative process.  As an example, let’s construct a 

http://www.utexas.edu/its-archive/rc/tutorials/matlab/ (60 of 145)11.09.2007 07:54:15



Matlab Tutorial

script to approximate  recursively from an iterative algorithm in which the user can set a limit 
on the number of iterations:
 
 

% script to illustrate user keyboard input
disp('Iterative approximation to pi');
reply = input('Limit to iterations? [y/n]','s');
if (reply == 'y')
    itmax = input('Maximum iterations?');
else
    itmax = 100;
end;
iter = 0; % initialize iteration number
res = 0.0001; % resolution for detecting change
prevpi = 2; % initialize a previous value
piapprox = 2 + 2/sqrt(2); % initial guess
while((abs(piapprox - prevpi) >= res)& (iter < itmax))
    prevpi = piapprox; % reset the previous value
    piapprox = 2 + 2/sqrt(piapprox); % new iteration
    iter = iter + 1; %increment iteration number
end;
iterations = iter
pi = pi
picalc = piapprox
difference = pi - piapprox

 
 
If you test out this script you will find that a consistent value is reached after six iterations even if 
more than that number is specified as the maximum.  Also you will also notice that the iterative 
convergence of the approximation is to a number very slightly less than the analytic value of .  
 
 
Multidimensional arrays and indexing
 
The fundamental unit in Matlab is a two dimensional matrix whose elements can be referenced 
by row position n and column position m.  These element locations are specified in parentheses 
following the matrix name, with the row position given first.  Thus, for example A(2,3) refers to 
the element of matrix A which occupies the second row and third column.  However, the contents 
of the matrix are stored within Matlab memory, regardless of how they may be displayed or 
referenced, as a single column matrix, i.e., a column vector, with sequential values column by 
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column.  Therefore an element in an N x M matrix A can also be referenced by a single index, A
(p) where  
 
p = (m-1)*N + n 
 
so that the last element in the first column has index p = N, the first element in the second column 
has index p = N+1, etc.
 
Matrices can be concatenated by defining a matrix of matrices, or by using the cat command, but 
of course the result of every concatenation must be a rectangular array.  As an example, suppose 
we have four simple rectangular matrices
 

             
 
These can be concatenated as
 
E =  [A  B]     giving a matrix of 2 rows and 6 columns
F =  [C; D]     giving a matrix of 6 rows and 2 columns
 
The cat command is equivalent, using a direction argument, 1 or 2, to specify concatenation in a 
column or in a row respectively.  Thus, we would get the same result as above by constructing the 
matrices E and F as
 
E = cat(2, A, B)
F = cat(1, C, D)
 
If an element position outside a matrix is referenced, there will be an error message displayed, 
for example when trying to display A(3,2) from above.  However, if an element outside the 
current range is assigned a value, Matlab will accept the assignment and fill in all other element 
positions necessary to form an expanded rectangular matrix with zeros.  We cannot directly 
concatenate all four of the example matrices above as
 
G = [A B;  C D]
 
because A and C have differing numbers of columns and rows, as do B and D.  However, if we 
assign a value (0 for example) to A(3,3), B(3,3), C(3,3), and D(3,3), then all four of the 
component matrices will be restructured as square matrices of dimension 3, padded with zeroes 
where not explicitly defined., and the assignment for G above can be processed.
 
Arrays of dimension greater than two can be useful, for specifying three dimensional coordinates, 
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assembling functional values determined by three or more independent variables, and so forth.  
Matlab was developed in the context of matrix algebra where most functions, matrix 
multiplication and so forth, are defined on the basis of two dimensional rectangular arrays, so two 
dimensional arrays are the primary objects.  Nevertheless, Matlab can accommodate higher 
dimensional array notation.  The positional index numbers can be expanded to three, four, or 
more.  However, display is still limited to two dimensional “cross sections” or slices, and the 
actual storage is again as a single column vector with an internal index for a multidimensional 
array element assigned sequentially by row position, then by column position, then by third 
index, and so forth.  Higher dimensions are not really amenable to visual conceptualization, but 
think of a four dimensional array being like a set of books along a shelf, each having the same 
number of pages and with each page having a same size rectangular matrix.  If there are five 
books each with six pages of matrices with seven columns and eight rows, then a particular 
element in the array Z with all the aggregate matrix elements could be referenced in 
multidimensional form as Z(row, column, page, book), e.g. Z(1,2,3,4) for the first row and second 
column of the matrix on page 3 of book 4.  This would correspond to an alternative single column 
internal storage reference. Before book 4 there are three books with six pages with 7 x 8 matrices, 
thus containing 3*6*7*8 = 1008 total elements.  Then before page 3 there are two pages with 7 x 
8 matrices, thus containing 2*7*8 = 112 total elements. Finally, there is one column before the 
second, in the matrix on page 3 of book 4, thus containing 1*8 = 8 total elements.  Hence the 
internal indexing would assign 1008 + 112 + 8 = 1128 positions before getting to Z(1,2,3,4).  
Therefore, the programmer could reference Z(1,2,3,4) alternatively by Z(1129) in this example.
 
Debugging
 
Matlab has extensive features to assist in debugging program errors, both compile time errors that 
primarily involve user mistakes in syntax and run time errors which either interrupt execution or 
produce unexpected or erroneous results.  Help for both command line input and m-file source 
code debugging is available.
 
The Matlab interpreter will display error messages in the Command Window when it encounters 
some operational instruction that it cannot understand.  Typically it will give some feedback 
about the problem, including a line number if the error is in an m-file.  For example, suppose at 
the command line we type
 
>> x(0) = (1^0)/factorial(0)
 
The interpreter will respond with 
 
??? Subscript indices must either be real positive integers or logicals.
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because array indices are restricted to be positive integers.  This could also happen if the problem 
occurred within an m-file script.  Let an initial version of a script ebase.m, which is supposed to 
find the value of the natural logarithm base be constructed as
 

%script to find the natural logarithm base e
evalue = 0;              % initialize the value
prev = -1;               % initialize a previous value
n = 0;                   % initialize index
while (evalue ~= prev)   % iterate if still converging
      nterm(n) = (1^n)/factorial(n);  % next term
      prev = evalue;     % update previous value
      evalue = prev + nterm(n);       % update value
      n = n + 1;                      % increment index
end;
evalue                   % show final value

 
There will be the same syntax error concerning a non-positive integer index shown, but this time 
there will also be an additional diagnostic comment of the form
 
Error in ==> ebase at 6
      nterm(n) = (1^n)/factorial(n);  % next term
 
We, as the user, can then edit the script to make an adjustment.  If we do not care about keeping 
the values of the individual terms in the series we can merely convert nterm to a transient valued 
scalar by removing the index , or we could fix the problem by replacing nterm(n)  with nterm(n
+1) in the script.
 
Run time errors are usually more difficult to spot and correct, and there are sometimes several 
possibilities as to the origin.  Operations that would terminate execution in other programming 
environments do not always do so in Matlab.  For example value assignment involving division 
of a non-zero number by zero will give an assignment of Inf (infinity) without stopping program 
execution.  Likewise, assignment involving division of zero by zero produces an assignment of 
NaN (not a number), without halting execution.  Errors in logic from user programming can lead 
to false calculations without giving any diagnostic warning.  In the ebase.m script for obtaining a 
value for the natural logarithm base, suppose the series term had been written as
 
nterm(n+1) = (1^n)/gamma(n);
 
where we have made the logic mistake of using gamma(n) rather than factorial(n).  Because the 
gamma function for a positive integer is actually the factorial function of that same integer 
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argument less one, i.e.,
 
gamma(n) = factorial(n-1);
 
we have a logic error in user supplied instruction.  The function gamma(0) will evaluate to Inf so 
that the first series term computes to zero with the result that the base value for natural logarithms 
remains at the initialization value without any subsequent iteration being performed.  This error 
in logic can be fixed by the user via changing gamma(n) to gamma(n+1), or its equivalent, 
factorial(n). 
 
Other common logic errors that will not cause termination of program execution are things such 
as infinite loops, mistakes in operator precedence or grouping, unintentionally overwriting a 
variable value from name duplication, and systematic propagation of round-off or truncation 
error.  There are several methods to use in tracking down such errors.  One straightforward way is 
to delete the semicolons from the end of assignment instruction lines so that variable values are 
displayed in the Command Window during program execution.  Another method is to have some 
user-specified diagnostic string displayed at certain designated points in the coding or whenever 
some logical condition (such as the value of a variable exceeding a certain number) is satisfied.  
This can be done with the disp command, which displays the value of its argument in the 
Command Window. The programmer can also insert instances of the keyboard command in the 
code, which will cause execution to halt and give a K>> prompt in the Command Window.  At 
this point instructions such as changing or testing a variable value can be given from the 
keyboard.  Upon a keyboard command of return, the program execution continues.  An example 
code to illustrate these techniques is the following for getting the value of a Riemann zeta 
function  from its infinite series definition, i.e., the sum of all reciprocals of positive integers 
raised to the power given as the argument.  We assume it has been saved in a file zeta.m.  This 
script should find an asymptotic value for zeta with an argument supplied within the code, in this 
instance 2.  The theoretical asymptotic value for (2) is , but we don’t know the rate of 
convergence, or the processor time needed.  To periodically check the progress and confirm that 
the program is not stalled or executing an infinite loop, a line has been included within the while 
loop to display the series term number after every hundred thousand iterations.  This is followed 
by a keyboard command to allow us to check the current sum from a command line prompt and 
terminate the loop if we think a sufficient value has been reached.   The script can be run in 
debug mode with Debug -> Save and Run from the Editor toolbar 
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From the keyboard let’s check the sum a couple of times at hundred thousandths term intervals to 
confirm that we are really in a long  process that indeed is converging to an expected value rather 
than being stuck in some unending computational process, then terminate the iteration when we 
reach an acceptable level of accuracy.
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Using Matlab with External Code
 
When developing programs to be run in Matlab or in another environment in which Matlab files 
can be called, there may be times when various interface tools will be needed.  A wide variety of 
such tools exist, but naturally they will be platform-dependent or source code language-
dependent.  Thus, there are not really any generic methods.  A developer will have to customize 
the tools for the particular circumstances.
 
Exchanging and viewing text information
 
Matlab programs can communicate with and use external code in many circumstances.  The 
simplest examples are transferring data to and from external files in the form of ASCII numerical 
matrices with the save and load commands.  Communication can also be on the level of 
examining and transferring ASCII text source code.  For example, consider a simple piece of 
ASCII text
 

function f = conevolume(r,h)
% volume of a cone with base radius r and height h
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f = pi*(r^2)*h/3;
 

saved in three formats in the Matlab Work folder: conevolume.doc (MS Word document), 
conevolume.txt (plain ASCII text document), and conevolume.m (Matlab m-file).
All can be opened from the Matlab Editor, but the MS Word document will contain binary code 
and not be useable.  Similarly, all these files can be opened and viewed as text in MS Word.  The 
MS Word text file can be used by Matlab if it is opened in an editor and saved as ASCII or m-file 
with a “.m” extension.
 
Compiling and calling external files from Matlab
 
Matlab can compile external FORTRAN and C code into MEX (Matlab EXternal) files using the 
mex command.  The executable is stored in a file with an extension that depends on the external 
platform.  Examples are filename.dll for a Windows platform and filename.mexsol for a Sun 
Solaris OS platform.  When compiled these external code files can be utilized just as if they were 
built-in Matlab scripts or functions.  As an illustration, let’s consider some code written in C that 
accomplishes the same task as the conevolume.m code above, compiled on a Windows platform.   
In order to avoid the confusion of having programs of the same name with various extensions in 
the same folder or directory, we will name the source code for this C version cvolume.c to 
distinguish it from conevolume.m
 

/*=====================================================
 * CVOLUME.C volume of cone from base radius and height
 *   Calling syntax:    v = cvolume(r,h)
 *===================================================*/
 
#include <math.h>
#include <mex.h>
 
/* Input Arguments */
 
#define   R_IN prhs[0]
#define   H_IN prhs[1]
 
/* Output Arguments */
 
#define   V_OUT     plhs[0]
 
#define PI 3.14159265
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static void cvolume(
             double v[],
             double r[],
             double h[]
             )
{
    
    v[0] = PI*r[0]*r[0]*h[0]/3;
    return;
}
 
 
void mexFunction( int nlhs, mxArray *plhs[], 
                  int nrhs, const mxArray *prhs[] )
     
{ 
    double *v; 
    double *r,*h; 
 
    V_OUT = mxCreateDoubleMatrix(1,1, mxREAL);
 
    /* Assign pointers to the various parameters */ 
 
    v = mxGetPr(V_OUT);
    r = mxGetPr(R_IN); 
    h = mxGetPr(H_IN);
        
    /* Do the actual computation in a subroutine */
    cvolume(v,r,h); 
    return;
    
}
 

You can see that the C code is quite a bit longer and more complex, so normally you would just 
use the Matlab programming language to do such a simple calculation.  However, there may be 
occasions when execution time can be improved by using compiled code of another language.  
This situation can occur, for example, when the Matlab code involves extensive looping or 
iterating.  Also, some other languages may have libraries available for specialized purposes or 
functions.
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To compile this code, you will need to setup for MEX files if you have not done so already.  At 
the Command Window Matlab prompt, type
 
>> mex -setup
 
and you will subsequently be prompted for information about your computer’s operating system 
and the compiler that you want to use.  UNIX systems usually have FORTRAN and C compilers 
such as f77 or gcc installed, but Windows platforms may not come configured with any.  Thus, 
Matlab has a bundled compiler, Lcc, which is used as the default C complier if no other is 
specified.  Unfortunately the current release of Matlab does not have a bundled FORTRAN 
compiler.  After finishing the setup, you should be ready to compile programs, at least ones 
written in C.  The syntax for compiling is to give the file name and extension as the target for the 
mex command, e.g.

 
>> mex cvolume.c

 
to compile the C code given in the illustrative example.  If you do this on a Windows platform, 
you will generate an executable cvolume.dll.  If you compile it on a Solaris platform, you will 
generate an executable cvolume.mexsol, etc.

 
Once you have done the compilation, you can use the command cvolume at a Matlab prompt and 
get the same answer as you get using the command conevolume whose source is a Matlab 
language m-file.  The volume of a cone which has a base radius 1 and a perpendicular height 1 is 
computed by these two codes as

 
>> volume_Matlab = conevolume(1,1)

 
volume_Matlab =
 
1.0472

 
>> volume_C = cvolume(1,1)

 
volume_C =
 
1.0472
 
The current distribution of Matlab has a more elaborate example based on a three body orbital 
dynamics problem, which consists of an m-file yprime.m and an equivalent C code version 
yprime.c that can be compiled as a MEX-file.  Those example files are located in the directory or 
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folder Matlab_root -> extern -> examples -> mex
 
 
Calling Matlab objects from external programs
 
Matlab has an engine with functions that allow it to act as a callable external function or 
subroutine library in FORTRAN and C programs.  The functions open the Matlab engine, close 
the engine, get and send matrix arrays, and evaluate Matlab strings. There is extensive 
information about these in the built-in Matlab help utility, with examples of FORTRAN and C 
programs that call the Matlab engine.  External FORTRAN and C programs can also call binary 
Matlab files such as those created by default with the save command.  The save command with 
no format flag will save the current workspace information in a binary file format (MAT) with a 
default name filename.mat, or the default matlab.mat if no file name is supplied.  MAT file 
information can be accessed by external programs with commands similar to those for the Matlab 
engine.  There is extensive information about the commands for exchanging data with external 
programs using MAT files in the built-in Matlab help utility. 
 
Using Java Classes in Matlab 
 
The desktop interface that is used for Matlab was developed and written in Java.  As a result, 
Matlab has an integrated Java Virtual Machine (JVM) and Java classes can be used directly in 
Matlab at the command line or within function m-files.  Before usage, there must be a file with 
the name classpath.txt in the Matlab search path.  Matlab has a default file located in the folder or 
directory Matlab_root -> toolbox -> local.  This can be copied to a directory in the Matlab path 
and edited if the programmer has created classes other than those in the default list.
A class or a package of classes can be imported into the workspace with the import command.  If 
this has not been done for a particular class, that class has to be referenced by its complete name.  
As an illustration, consider a simple example where the default classpath.txt file has already been 
copied to the current working directory and the Java awt class package has been imported but the 
Java lang class package has not.  In this case we can use a class name from the imported package 
directly on the command line but must give the complete full name for a class in the package 
which has not been imported
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The Dimension class is recognized because its package has been imported, but the String class is 
not recognized as a Java class because its package has not been imported.  However, if the 
complete name of the String class, i.e., java.lang.String, is used then the Matlab interpreter 
recognizes it as a Java class.
 
 
 
 
 

Part III:  Graphics and Data Analysis
 

Section 7:  Graphics and Data Visualization
 

Matlab has a high level graphics capability that allows users to display data in various forms 
without having to incorporate extensive information into a command or into scripts.  This easy 
procedure uses default values for graphical objects in Matlab’s object oriented graphics system, 
Handle Graphics.  For more customized and advanced use, the values can be specified or changed 
on the command line or in the text of m-file scripts; and there is also a point and click GUI for 
users to change object values in order to alter display characteristics.  Display possibilities 
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include 2-D plots, 3-D plots, visual aids such as pie charts and histograms, contours, and 
animation.  In addition there are many attributes of objects that can be customized, including 
scaling, colors, fonts, perspective angles, lighting and shading, and so forth.
 
 
Two dimensional plotting
 
The high level graphics for two dimensional plotting accommodate displays of pairs of data sets 
in rectangular linear Cartesian coordinates, on a semilog axis system, on a log-log axis system, 
and in polar coordinates.  The elementary syntax is 
 
>> plot(x,y)        % linear abscissa and ordinate

>> semilogx(x,y)    % logarithmic abscissa (x)
>> semilogy(x,y)    % logarithmic ordinate (y)
>> loglog(x,y)      % both x and y logarithmic
>> polar(theta,rho) % polar graphing

 
If only one vector argument is supplied, it is considered to be the second (dependent) variable, i.
e., the ordinate or radial distance, and the sequence position in the vector is used for the 
corresponding independent variable, i.e., abscissa or counterclockwise angle.  When a vector 
containing complex valued quantities is plotted, Matlab ignores the imaginary part and the 
display represents only the real part.  Trailing character string options in the argument list can 
specify a line color or type. 
 
As an example, let's load a file that is distributed with Matlab for demonstration purposes, 
sunspot.dat, and make various two dimensional plots.  The file is a simple
288 row by 2 column matrix where the first column has consecutive years from 1700 until 1987 
and the second column has the mean sunspot number for that year.  Then we will construct year 
and spots vectors from the two columns and plot spots as a function of year.
 
 
 

>> load sunspot.dat;
>> year = sunspot(:,1);
>> spots = sunspot(:,2);
>> plot(year,spots);

 
This would give a 2-D plot displayed as a line going through the points. We could obtain a 2-D 
plot with point markers if we added a third string argument, e.g., 'r*' for data points being 
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displayed as red asterisks.  There is a toggle for getting a new plot (hold off) and for 
superimposing on an existing plot (hold on).  Assume that we want a second plot with the data 
markers superimposed on the line plot, with the same scaling.   Then we would use the additional 
commands

 
>> hold on;
>> plot(year,spots, 'r*')

 
 

 
 
There are also several display options for discrete data that are commonly used in presentations 
for general or business audiences
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bar    for a vertical bar graph
barh  for a horizontal bar graph
stem  for a stem plot
area   for display of vectors as stacked plots
pie     for a pie chart
hist    for a histogram in Cartesian coordinates
rose   for a histogram in polar coordinates
 
For example, to get a histogram of sunspot number during the time span with 50 bins you could 
use the command
 
     >> hist(spots,50)
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Sub plotting
 
It is possible to display several subplots simultaneously in a rectangular array within a single 
figure using the subplot command.  This command takes three numerical arguments, followed by 
a comma and a regular plotting command – thus the form
 
>>subplot(n1,n2,n3), plotfunction(x, y, ...)
 
where n1 is the number of rows in the subplot array, n2 is the number of columns in the subplot 
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array, n3 is the position within the array for the particular subplot, and the plotfunction is a 
regular plotting function such as plot, stem, bar, etc.  The position is defined as  
 
n3 = (row_position – 1)*n2 +  column_position  
 
so that the upper left position has n3 = 1, the upper right position has n3 = n2, the lower left 
position has n3 =  (n1 -1)*n2 + 1 and the lower right position has n3 = n1*n2.
 
Some of the plotting variants can be illustrated compactly with a subplot, using the first few 
cycles of approximately 11 years:
 
>> hold off;
>> subplot(2,2,1),  stem(year(1:33,1), spots(1:33,1));
>> subplot(2,2,2), bar(year(1:33,1), spots(1:33,1));
>> subplot(2,2,3), barh(year(1:33,1) ,spots(1:33,1));
>> subplot(2,2,4), area(year(1:33,1), spots(1:33,1));
 
 

 
Patching and Filling
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An area of a plot can be filled with a specified color or pattern if its boundary can be described as 
a closed polygon.  The command
 
>> patch(x,y,'color');
 
will fill the polygon having vertices at [x(1),y(1)], [x(2),y(2)], … with the specified color, which 
can be a character code such a 'r' for red, or an RGB vector such as [1 0 0] for red.  This patching 
applies to the current figure, whether hold is on or off.  Similar to this is the command fill, 
 
>> fill(x,y,'color'); 
 
but this is a plot command itself and if hold is set to off the current figure is replaced by a new 
one containing only the colored polygon.  
 
 
 
Three dimensional plotting
 
Matlab has several commands used in displaying data in three dimensions.  Among these are 
routines for displaying lines with a 3-D perspective, making surface plots of a function of two 
independent variables, and making contour plots.
 

>> plot3(x,y,z)  % line in three dimensional space
>> mesh(q)       % wire frame surface for q(x,y)
>> surf(q)       % quadrilateral surface rendering
>> contour(q)    % 2D projection of equal height lines 

 
The plot3 command requires 3 vector arguments, the first two forming a grid of independent 
variable values and the third being the functional values obtained from the independent variable 
values.  Thus, all three vectors must be the same length.  In contrast, the argument for the surface 
plots require that the argument be a matrix whose values correspond to pairs of independent 
variable values in a grid.  
 
Matlab does not come with an experimental data set equivalent to the sunspot data that can be 
used for illustrating 3-D plotting.  However there are a couple of suitable files accessible from the 
Research Consulting web site.  Find the documents at
 
http://www.utexas.edu/its/rc/tutorials/matlab/popcenter.dat 
http://www.utexas.edu/its/rc/tutorials/matlab/wireless.xls 
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and put copies of them in a location within your Matlab path. The first of these files is a matrix of 
U.S. Census Bureau data with a column for all the decennial census years (1790-2000) and 
separate columns for the geographical coordinates of the center of U.S. population for those 
census years.  The second column is the north latitude coordinate and the third column is the west 
longitude coordinate.  The second of these files is an Excel spreadsheet giving the mean number 
of simultaneous users of the University's wireless network by day of the week and hour of the day 
during the Fall 2004 semester.
 
As an illustration of plotting a line in 3-D space, set each of the three columns of the popcenter.
dat file to separate vectors and then use those as the arguments for plot3 command:
 

>> clear;
>> load popcenter.dat;
>> decade = popcenter(:,1);
>> north = popcenter(:,2);
>> west = popcenter(:,3);
>> hold off;
>> plot3(north, west, decade);

 
The screen display will use default values for observation angle where the minimum value for the 
first and second arguments is closest to the viewer.
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This shows the southwestward drift of the center of population in the U.S. with each new census, 
particularly in recent decennial years. More perspective of the 3-D nature of the curve can be 
obtained from rotating it in 3-D by selecting the Rotate3D item on the Figure Window's Tool 
menu bar or by clicking the rotation button at the end of the Figure Window's icon tool bar, then 
moving the cursor to the figure area and moving the mouse around while depressing its left key.
 
To illustrate surface plotting, let us import the data from wireless.xls.  A simple procedure for 
doing this is to open the file with the command
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>> open('wireless.xls')
 
and then select the variable data (a 96 x 7 matrix) for import.  This has the mean wireless usage 
volume numbers for the 96 quarter hours of the day for each of the 7 days of the week. 
 

 
Then let us create a surface plot of the imported variable data:
 
>> surf(data)
 
The 3-D surface will subsequently appear in the Figure Window.  
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Just as with the line example, the surface can be rotated in 3-D using the same procedures.  If a 
contour projection onto the grid plane is desired, the contour command can be used 
 
>> contour(data)
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This gives a projection of lines of equal value of the dependent variable in the matrix elements 
projected onto the underlying grid of the two independent variables, much like contour lines seen 
on topographical maps.  If it is desired to have a surface and its contour both displayed in the 
same figure then the function surfc can be used.  Likewise, the commands
 

>> mesh(data)
>> meshc(data)

 
would create similar 3-D plots, but with the surface represented in a wire frame display.
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Animation
 
Data animation in Matlab is accomplished by a sequential display of graphic frames.  At an 
elementary level the frames can be simple plots of points within a Figure Window.  If the hold 
value is set to off, then each point will appear by itself, creating a display similar to a moving 
cursor on the screen.  If the hold value is set to on, then each frame will incorporate the data from 
previous frames and the display will show a trajectory tracking type of pattern.  In some cases 
this method may seem a bit crude because of blinking as each frame replaces the previous one, 
and delays in generating frames if needed computations are extensive or complex.   As an 
example, suppose that we want to track the trajectory of the sunspot number over time.  We could 
use the following script, placing it in the Matlab path with a the name trajcetory.m
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A trajectory animation would then be produced with the command
 
>> trajectory
 
An alternative procedure is the use of the movie feature.  For this, a set of frames is assembled 
ahead of time into a movie type variable using the getframe function.  Subsequently, the sequence 
of frames can be played in the Figure Window using the movie command.  This command has 
three arguments: a required vector of movie frames, an optional number specifying the number of 
times the movie is played in a loop, and an optional number specifying the frames per second 
speed for the movie display.  An illustrative m-file for creating a movie demonstrating sunspot 
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number over time is 
 

 

 
If this script is in the Matlab path with the name sunspotmovie.m, the movie can be displayed 
with the command
 

http://www.utexas.edu/its-archive/rc/tutorials/matlab/ (86 of 145)11.09.2007 07:54:15



Matlab Tutorial

>> sunspotmovie
 
You should see a static circular (actually a 100 side normal polygon) yellow "sun" with an 
interior gray spot that changes its intensity according to the magnitude of the dynamic sunspot 
number when cycling through the years.  In this instance the movie loop is played one time at 30 
frames per second.
 
 
 
 
The Handle Graphics system
 
Handle graphics is Matlab’s object oriented system for handling components used in constructing 
graphical displays.  The objects are the basic drawing elements.  Each object is identified with a 
handle and the handle contains information about the object's characteristics and properties.  The 
GUI provides a convenient point and click method for changing graphic properties, but it does 
not have quite the same level of control as you get when making changes at the command line or 
within a script.  For practice using the point and click method, create a basic plot, e.g., 
 

>> clear
>> load popcenter.dat;
>> north = popcenter(:,2);
>> west = popcenter(:,3);
>> hold off;
>> plot(west, north, 'b*');
>> hold on;
>> plot(west, north, 'b');

 
This will make a simple 2-D plot of the geographical coordinates for the U.S. population center at 
decennial years displayed as blue asterisks with a line connecting them.  In this case the default 
values in the handles will produce a plot figure where there is no title, the axes scaled to the data 
range, inward tick marks with values on the left and bottom, and the data represented by a solid 
blue line.  Then for point and click editing, click on the white backward arrow in the toolbar of 
the Figure Window and select the property that you want to edit from the Edit pull down menu on 
the top navigation bar.  For example, select Edit > Axes Properties and a property editor window 
will appear.
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You can toggle between tabs for setting or adjusting properties for the X, Y, and Z axes, and also 
click on boxes to enable grid lines on any of those axes.  Let's check the boxes to show the Grid 
on the X axis and on the Y axis corresponding to latitude parallel and longitude meridian lines.  
There will be a More Properties button that can be clicked to bring up a Property Inspector 
window to let you select further properties.  As an example, from that window scroll down to 
where the LineWidth option appears and edit the value space so that it reads 2.0 as a replacement 
for the default 0.5, resulting in thicker axis lines.  There are also two buttons for color pallets on 
the Property Editor window, one for the axis lines themselves and another for the plot 
background.  Select a color from the background pallet so that it changes from the default white, 
yellow for example.  Also select a color from the line pallet, purple for example.  Changes are 
applied immediately in the Figure Window:  Now type in a title for the figure in the Title box, for 
example "US  Population Centers", since this is plot being made.  If you then click back on the 
Figure Window, the title that you have specified will appear.  Now, edit a figure property from 
Edit > Figure Properties.  In the Figure Editor, change the background color for the figure, for 
example to a light blue.  To practice changing the appearance of a specific object, click on the 
plotted line in the Figure Window to select it, then use Edit > Current Object Properties.  A 
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Property Editor window for the selected line will appear.  After clicking on the More Properties 
button, change the line width from the default 0.5 to 2.0 again.  Then let's change the line color 
from the default blue to red, which can be done after clicking on the line color pallet button in the 
Property Editor window.  There are also separate color pallet buttons for marker faces and edges 
for instances where the data points are displayed as objects rather than a line.  At this point the 
figure should look like the following:
 

 
Now return to the Axes Property Editor by selecting it from the Edit Menu once again.
Clicking on the Ticks button opens up another window in which you can edit tick mark positions.  
Other axis properties can be changed by clicking on the More Properties button, which also 
opens up another window where variable values can be selected or edited.  For most purposes, 
this point and click interface will be sufficient to customize a plot display as you want it to 
appear.  One thing we might do is select the Reverse boxvalue on the X Axis tab of the Axes 
Property Editor window because maps usually have increasing west longitude going from right to 
left.  Also, in the Axes Property Editor window we can also specify the label for the X axis as 
'West Longitude' and the label for the Y axis as 'North Latitude'.  We might also want to use fixed 
scaling for the axes instead of automatic scaling so that the map would cover all the 48 
contiguous states.  To accomplish that you can click on the More Properties button, then scroll to 
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XLim.  You may need to expand this to show x and y (a bit confusing because these are lower and 
upper boundaries for the X axis).  Change the automatic limits to a lower bound of 66 and an 
upper bound of 125.  Similarly for YLim change the limits to a lower bound of 24 and an upper 
bound of 50. 
 
A plot can be manipulated with threaded input back and forth from the point and click property 
editors and the command line.  For example suppose we now want to insert some geographical 
reference markers onto the plot.  We can do this by inserting black circle markers at large cities 
near extremes of the country and near the original and most recent population center data point
 

>> plot(71, 42, 'ko') % Boston;
>> plot(80, 26, 'ko') % Miami;
>> plot(117, 33, 'ko') % SanDiego;
>> plot(122, 48, 'ko') % Seattle;
>> plot(77, 39, 'ko')  %Baltimore (near 1790 point);
>> plot(90, 39, 'ko') % Saint Louis (near 2000 point); 

 
These commands display the landmark positions but not the identifying names.  The names of the 
landmarks can be added by deselecting the backward white arrow, then selecting Insert > 
TextBox from the navigation bar.  You can position the text string by clicking the mouse at the 
position where you want it to start.  After typing in the desired text and hitting Enter you will 
automatically be put back into the white back arrow edit mode where you can adjust the position 
by dragging with the mouse.  A visible box around the text is the default, but this can be removed 
by returning to the navigation bar and going to Edit > Current Object Properties.  A Textbox 
Property Editor window will appear, in which you can select the Line Style as no line.  While 
there you can also change the default FontWeight from Normal to Bold in order to provide greater 
contrast.  You may need to select the text within the textbox before trying to change the font 
weight.  If you follow this procedure for each of the landmarks, your plot should look similar to
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In situations where point and click editing is not sufficient, or if you want to use some specific 
display template repeatedly and would like it incorporated into a script, Matlab has the capability 
of assigning specific values of object properties using handles.  There are two specific built-in 
graphics handles that are used for default plotting. The handle gcf refers to the current figure and 
its information is used for generating a Figure Window when none exists at the time a command 
producing graphical output is issued.  The handle gca refers to the current axes and likewise its 
information is used for constructing axes when none exist at a time a plotting command is 
issued.  The handle gco refers to a graphical object that has been selected in the Figure Window.  
It will be empty if there is no Figure Window present or if an object has not been selected.  If a 
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figure object has been selected then information about that object's properties will be present in 
gco. The current values within these handles can be obtained with the commands
 
     >> get(gcf)
     >> get(gca)
     >> get(gco)
 
To get a listing of values available for the handle variables in addition to the current value, use 
the set command with only the handle of interest as the argument
 

>> set(gcf)
>> set(gca)
>> set(gco)

 
 
Current values may be edited using the syntax  set(handle,'Property',value).  Let's make a couple 
of changes from the command line using the handle syntax.  Use get(gca) to examine the current 
settings for XMinorTick and YMinorTick.  They should be listed as 'off'.  Next we will use set
(gca) to see what other options in addition to 'off' are available.
Options will be within square brackets separated by pipes, with the default value within curly 
braces.  For the minor tick variables we see the options as
 

XMinorTick: [ on | {off} ]
YMinorTick: [ on | {off} ]
 

so let's use the alternative values of 'on' by executing the commands
 

>> set(gca, 'XMinorTick', 'on');
>> set(gca, 'YMinorTick', 'on');   

 
One word of caution should be noted.  The handle gca lists XLabel, YLabel, ZLabel, and Title as 
variables but they are actually themselves handles to Text objects and need to be referenced 
directly.  The procedure for setting or changing the value of any of these four from the command 
line or within a script is to reference them directly. For example, though obvious suppose we 
decide that we need to specify that the longitude units are in degrees.  We could adjust the 
labeling of the horizontal axis with the command
 

>> XLabel('West Longitude (degrees)');
 
This would create the new text string and overwrite what was already there.  Once all the editing 
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has been finished, the edit mode white back arrow can be deselected and the Property Editor 
Window closed.  The final plot would look like
 

 
 
Saving and exporting graphics
 
Whatever static graphic you have created, in 2-D or 3-D, it will be displayed in a Figure Window 
with a default name Figure1. With File > Save or File > Save As, the image of the entire Figure 
Window can be saved to disk with the default location being the Current Directory, the default 
format being a Matlab Figure file (*.fig), and the default name being untitled.fig.  However there 
will be a small window created with functionality for navigating to a different directory and for 
specifying a different name and format.  The default format, Matlab Figure file, cannot always be 

http://www.utexas.edu/its-archive/rc/tutorials/matlab/ (93 of 145)11.09.2007 07:54:15



Matlab Tutorial

directly pasted or imported into other documents so you may wish to save or export to a more 
commonly accepted format such as JPEG image (*.jpg).  Some manipulation of the graphic 
image before saving to a file format is also possible using File > Export Setup.  This will produce 
a window giving you several options for changing dimensions, fonts, lines, rendering, and so 
forth.  After making any desired changes you can then click on the Export button and you will get 
the Save As window for specifying directory, file format, and file name.
 

 
 
 
 
 
 

Section 8: Data Analysis
 
Data analysis functions
 
Matlab was not developed as a statistical package, yet there are some elementary statistical 
functions built into the kernel and there is a specialized Statistics Toolbox available for purchase 
from Mathworks but which is not currently included in the license for Matlab on the ITS servers.  
Among the functions distributed with Matlab itself are
 
mean        for arithmetic mean or average value of elements
median     for median value of elements
min           for smallest component
max          for largest component
var            for variance of the elements in a vector
std            for standard deviation from the mean of elements
sum          for sum of elements
prod         for product of elements
sort           for sorting elements within a vector
sortrows   for sorting rows within a matrix by values in a column
cov           for variance of a vector or covariance of a matrix
corrcoef   for correlation coefficient
 
 
Descriptive statistics
 
The elementary descriptive statistics functions that come with the general Matlab distribution can 
be used with vector or matrix arguments.  By default Matlab assumes that columns are variables 
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and rows are cases.  If a matrix is given as the argument of one of these functions, the operation is 
applied to each column independently.  Thus, if a statistic for rows of a matrix is desired, the 
function should use the matrix transpose as the argument.  Let's use the data matrix variable 
above imported from the wireless.xls file to create some examples.  Recall that this has 7 columns 
corresponding to the seven days of the week and 96 rows corresponding to the quarter hours of 
the day. To get the mean value of the quarter hourly wireless connection volume for the days of 
the week, rounded off and displayed in a column we would use the command
 
 
 
 
 
 
 
>> meanvol = round(mean(data)')
 

meanvol =
 
                        171
          576
          573
          539
          489
          313
          113
 
The mean quarter hour volume on Sundays was 171, on Mondays it was 576, etc.
Suppose we wanted the median quarter hourly volume on Wednesdays.  Then we could specify 
the particular column, i.e., column 4, for that day
 
>> wedmedian = median(data(:,4))
 
wedmedian =
 
                     364.5
 
Note that for the median function the value returned is the average of two mid range values when 
the vector length is an even number.  Now let's get a statistic by rows instead of column.  For 
example, if we wanted to know the variance of volume during the week for each quarter hour 
time of day, we could use the command
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>> qhourvar = round(var(data'))'; 
 
This transposes the data matrix so that the quarter hour rows become columns, puts the variance 
of each of those columns into a row vector, transposes that row vector back to a column and 
rounds off the resulting values.  The result is a column vector of the variances
 
qhourvar =
 
          4576
          3924
          3275
          {etc.}
 
indicating a variance of 4576 at midnight, 3924 at 00:15AM, etc.  As a last example, suppose we 
want to know which quarter hour time had the greatest and least variance.  For this we could use 
the max and min functions.  With only the vector name as an argument, the max and min 
functions will return only the greatest and least value in the vector without specifying where it 
occurs.  To get the vector index where it occurs, the assignment needs to refer to a two element 
vector.  
 
>> [qhourvarmax maxindex] = max(qhourvar)
 
qhourvarmax =
 
          288659
 
 
maxindex =
 
          46
 
Thus, the maximum quarter hour volume variance of 288659 across the week occurs at the 46th 
quarter hour of the day (i.e., 11:15AM).  Similarly we would find that the minimum quarter hour 
variance of 60 across the week occurs at the 24th quarter hour of the day (i.e., 05:45AM).
 
Sorting
 
The sorting functions are by numerical value including sign for numbers, by absolute value when 
complex numbers are involved, and alphabetically or by ASCII character code value when 
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character strings are involved.  When the argument is a matrix, the sort function operates on each 
vector along the sorting dimension independently.  Syntax is
 
>> sort(x,n,'direction')
 
where x is the vector or matrix containing the data, n is the dimension for sorting (1 for rows, 2 
for columns, 3 for a third index, etc.), and direction is either ascend or descend. The default value 
for n is 1, i.e., sort by rows if the data is in a matrix, and the default value for direction is ascend, 
i.e., sort by ascending value.  These default values are used if only a data matrix is given as an 
argument.  Group sorting is also possible with the sortrows command.  Syntax for this command 
is
 
>> sortrows(x,n)
 
where x is a data matrix of columns and rows and n is a scalar or vector of integers that specify 
the column order for subsorting with the direction being descending if an integer has a minus 
sign.   For illustration, let's use the data matrix popcenter from the previous section on graphics.  
It was constructed with row sorting by ascending census year already done, but suppose we want 
the rows sorted by descending north latitude in column 2 instead.  We could construct a revised 
data matrix with this feature with the command
 
>> northsort = sortrows(popcenter, -2)
 
 
 
 
Regression and curve fitting
 
Matlab has a function polyfit for fitting curves with polynomial regression and the function 
polyval for evaluating the polynomial fit.  The polyfit function has syntax
 
>> polyfit(var1, var2, order)
 
where var1 and var2 are equal length vectors and order is the order of the polynomial to be used 
in the fitting.  For illustration, let's use data from the popcenter matrix obtained from loading the 
popcenter.dat file and try to fit the mean center of population migration pattern to a polynomial 
function, first to a first order polynomial (linear regression), then to a higher order polynomial, in 
this instance a cubic.  The following script, popcenterfit.m, shows how this can be done and the 
results displayed in a graphic figure.
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The two coefficients for linear regression are put into the linfit variable vector and the four 
coefficients for cubic regression are put into the cubicfit variable vector.  Subsequently the 
regression curves are plotted on top of the experimental data using the polyval command.   This 
command creates function values from a vector of polynomial power coefficients and a vector of 
function argument values.  In the curve fitting done here you can see that linear regression does 
not give a very good fit compared to the fit with cubic regression.  Remember though that this is 
just optimization of coefficients to minimize least square residuals using the particular data set, 
and higher order fits, though seemingly more accurate, may have very high sensitivity to 
perturbations
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This can also be seen by running the popcenterfit.m script and looking at the sum of the squares 
of the residuals:
 
>> popcenterfit
 
res2sumlin =
 
              2.09513077385494
 
 
res2sumcubic =
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          0.0845722500061468
 
This illustration uses observational data and shows the technique of curve fitting, but of course 
there is no theoretical foundation for expecting that the north latitude of the US population center 
would have a cubic relationship to the west longitude, or any explicit mathematical dependency 
at all for that matter.
 
Signal processing
 
Signal processing tasks in Matlab usually involve characterization or manipulation of time series 
vectors.  This can involve evaluation of parameters of periodic behavior, finding trends, or 
removing distracting contributions such as noise.  Matlab itself has functions for some types of 
elementary signal processing, and there is a specialized Matlab Signal Processing Toolbox 
(included in the ITS license) which contains function m-files that are algorithms for 
implementing several more advanced signal processing tasks.  These include specialized 
functions related to filtering, waveform generation and spectral analysis, along with a special 
GUI called SPTool.
 
The sunspot.dat file provides a good data set for illustrating some FFT techniques.  Let's create a 
power spectrum of the yearly sunspot numbers and see the dominant frequencies.  Recall that we 
named the sunspot number vector spots and the sampling rate to get the time vector that we 
named year was one point per year.  The power vector will be an element by element 
multiplication of the FFT function with its complex conjugate
 
>> power = fft(spots).*conj(fft(spots));
 
and the frequency vector will be 
 
>> freq =  (1)*[0:length(year)]'./length(year);
 
The FFT algorithm takes advantage of complex conjugate symmetries of roots of unity, but this 
results in half of the power spectrum (that above the Nyquist frequency) being redundant.  Also 
the first element of the FFT vector is always the sum of all elements in the original time domain 
vector.  Therefore in plotting a power spectrum it is typical to restrict the points displayed to the 
range from 2 to half the length, e.g., since our vector includes data for 288 years,
 
>> plot(freq(2:144), power(2:144));
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The period associated with strong peak at about 0.09 is the reciprocal of its frequency value, i.e. 
(1 year/0.09), or about 11.1 years -- which is the classical sun spot cycle length.
 
The most elementary filtering function, filter, is included in Matlab and has the syntax
 
     >> output = filter(numcoeff, denomcoeff, input)
 
where an output vector is formed from filtering an input vector with a transfer function whose 
numerator coefficients are contained in the vector numcoeff and whose denominator coefficients 
are contained in the vector denomcoeff.  A common use of this method is smoothing a curve with 
a moving average, such as is routinely done for monitoring long term trends in fluctuating stock 
market prices.  Let's use the sun spot data again and get a trend line by using a moving average 
window of 50 years, smoothing out the data over about four and a half cycles of the major 
periodic component.  For this the numerator vector is a row with 50 elements, each with value 
(1/50).  The denominator vector is simply a single element row vector with the value 1
 
>> numcoeff  = (1/50)*ones(1,50);
>> denomcoeff  = [1];
>> trend = filter(numcoeff, denomcoeff, spots);
>> hold off;
>> plot(year, spots);
>> hold on;
>> plot(year, trend, 'r');
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The red line in the plot thus shows a macroscopic trend in the value of the sunspot number 
beyond the large scale year to year periodic fluctuations.
 
Signal processing methods more elaborate than FFT and filtering can be found in the Matlab 
Signal Processing Toolbox.  For example, this toolbox has several wave generation functions.  
Some of the most commonly used are
 
sawtooth    for a triangle wave generator
pulstran      for a pulse train generator
square        for a square wave generator
 
As an illustration, let's generate a triangular, sawtooth shaped wave:
 
     >> hold off;
>> t = [0:0.1:20];
     >> x = sawtooth(t);
     >> plot(t,x)
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The sawtooth function is defined as -1 at multiples of 2π and linear with a slope of 1/π at all other 
points.
 
The Signal Processing Tool GUI is a feature available in the toolbox.  It is launched with the 
command
 
>> sptool
 
which creates a window with selections of  signals, filters, and spectra
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The view buttons on this window can be used to launch a Signal Browser, a Filter Viewer, or a 
Spectrum Viewer.
 
Image processing
 
If a task merely involves manipulating an image, you would probably not look to Matlab as the 
application of choice.  More likely you would use Adobe Photoshop or some similar product that 
was developed specifically for working with images.  Nevertheless there may be occasions where 
image manipulation is needed in the context of other operations, and there is a Matlab toolbox 
available when such instances arise.
This Matlab auxiliary, the Image Processing Toolbox (included with the ITS Matlab license) has 
m-file functions for manipulating arrays containing image information.  Also, many of the Signal 
Processing Toolbox functions can be used in conjunction with image processing.  Within the 
Image Processing Toolbox are routines for geometric operations, image analysis and 
enhancement, and region of interest operations.  But before working on an image, it has to be 
imported into the workspace.  This can be done with the load command if the image data has 
already been stored in a MAT file.  Images with supported formats (e.g., jpg, gif, tiff, png) can be 
imported with the imread command and displayed in the Figure Window with the imshow 
command.  Once an image has been processed as desired, it can then be exported in a supported 
format using the imwrite command.  As an example, let's import a low contrast image, tower.jpg, 
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enhance its contrast, and export a before and after comparison image.  For this exercise, you will 
need to put the image file in your Matlab path.  The process can be done with any image with a 
supported format, but in this case we choose a low contrast nighttime picture of the University 
tower, available for download at
 
http://www.utexas.edu/its/rc/tutorials/matlab/tower.jpg 
 
 
            >> I = imread('tower.jpg'); % create image data matrix
     >> imshow(I)                % display in Figure Window
 
Now let's add contrast with the histeq command.  This spreads out intensities over the entire 
possible range, and is particularly useful if actual intensities of all the pixels are clustered over a 
narrow range.  The jpg format has three layers for a color image and the histeq command requires 
them to be processed separately:
 
     >> for m = 1:3 % add contrast for each layer
          J(:,:,m) = histeq(I(:,:,m));
        end;
     >> K =  [ I J ];    % place old and new side by side
     >> imshow(K)        % display the contrast
     >> imwrite(K,'towercontrast.jpg') % write new file
 
Now there should be a new display in the Figure Window showing both the original and contrast 
enhanced picture side by side
 

http://www.utexas.edu/its-archive/rc/tutorials/matlab/ (105 of 145)11.09.2007 07:54:15

http://www.utexas.edu/its/rc/tutorials/matlab/tower.jpg


Matlab Tutorial

 
 
and there should also be a new image file, towercontrast.jpg, in the current directory.  In this 
exercise the data matrix is 3-dimensional, as can be seen in the Value column of the Workspace 
Window.  This is an RGB (red, blue, green) format, in which the primary color component is the 
third index.  The first two indices specify the vertical and horizontal position of the pixel, top to 
bottom, left to right.  Element values represent intensities.  Thus, for example, displaying an 
element in the original image data matrix 
 
            >> disp(I(50,50,2))
         13
 
tells us that the green intensity of the pixel in the 50th row and 50th column has an intensity value 
of 13.  
 
This is not the only format for storing image data information.  Image objects in Matlab can also 
be two dimensional data arrays.  The indices correspond to pixels in a rectangular image and the 
elements can be either magnitudes of intensity or pointers to color or intensity information in a 
separate color map matrix.  Color map matrices are three columns representing components of 
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the primary colors red, blue, and green.  Each row is a particular weighting of each of these in a 
range from 0 to 1.  Indexed matrices, whose elements point to the color map, will have entries 
corresponding to particular lines in the map.  The image whose pointers are in matrix X will have 
its pixel content determined by the RGB values in the associated color map matrix Y using the 
command
 
>> image(X), colormap(Y)
 
As a small example, let’s create a game board for chess or checkers.  First we will create the 8x8 
layout of the board.  Pixels whose row and column sum is odd need a different color from those 
whose row and column sum is even.  But the color within each set needs to be uniform, so only 
two lines are needed in the color map. First create the matrix with pointers to alternating colors
 
>> Z = [eye(2) eye(2) eye(2) eye(2)]; 
>> Z4 = [Z;Z;Z;Z];
 
The matrix Z4 has 8 rows and 8 columns with elements having alternating values of 0 and 1.  
Since there can be no row 0 in a color map we need to convert these two pointer indices so that 
they have values of 1 and 2 instead
 
>> C = 2*ones(8) - Z4;
 
Now C is the matrix of color map pointers for a checkerboard image. Next we create a color map 
with three columns for RGB values with two rows, one for each of the two colors whose pointer 
values are 1 or 2.  Let’s define the color map as the variable colors.
 
>> colors(1,:) =  [ 1 1 1 ]; % pointer value 1 white 
>> colors(2,:) =  [ 0 0 0 ]; % pointer value 2 black 
 
The image command will create a color pixel image, with the color map specified with the 
colormap command.
 
>> image(C)
>> colormap(colors)
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For a more intricate image with a more extensive color map, you can look at one of the example 
files distributed with Matlab.  One such binary file is mandrill.mat, a facial image of a gorilla, 
whose data includes the matrix X with pointer data and the color map matrix map.  Thus, the 
commands needed for viewing are
 
>> load mandrill
>> image(X)
>> colormap(map)
 
Another type of image format is one in which the elements of the image matrix are intensities 
rather than pointers to a mapping.  The command to generate an image from this format is 
imagesc.  We can see our previous checkerboard image from matrix C again with the command  
 
>> imagesc(C)
 
Images can be manipulated by changing their data matrices or color maps.  For example we can 
change colors for the black and white checkerboard by changing values in the color map matrix, 
for example to red and cyan with the command
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>> colors(:,1) = sort(colors(:,1))
 
or we can remove the blue component of the color map used for the gorilla image with
 
>> map(:,3) = 0;
 
Demonstrations of many other ways for manipulating and analyzing images are available in the 
documentation that comes with Matlab.  Select Demos from the Help menu of the main Matlab 
window and then expand Toolboxes and subsequently Image Processing to see these.
 
 
 
 

Part IV:  Modeling and Simulation
 
 

Section 9:  Modeling and Simulation
 
Matlab has several auxiliary Toolboxes distributed by Mathworks, Inc., which are useful in 
constructing models and simulating dynamical systems.  These include the System Identification 
Toolbox, the Optimization Toolbox, and the Control System Toolbox.  These toolboxes are 
collections of m-files that have been developed for specialized applications.  There is also a 
specialized application, Simulink, which is useful in modular construction and real time 
simulation of dynamical systems.
 
 
System Identification
 
The System Identification Toolbox contains many features for processing experimental data and 
is used for testing the appropriateness of various models by optimizing values of model 
parameters.  It is particularly useful in working with dynamical systems data and time series 
analyses.  This toolbox is included in the Matlab installations on all the ITS servers.  The 
identification process is a bit complex, but a guided tour through a simple example can be 
accessed with the iddemo command at a Command Window prompt.
 
 
Using the Control System Toolbox
 
The Control System Toolbox contains routines for the design, manipulation and optimization of 
LTI (linear time invariant) systems of the form
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where matrices A, B ,C ,D are constant.  It can be used individually or as a post-processing tool 
for a system created with Simulink. The Control System Toolbox also supports two auxiliary 
applications, the LTI Viewer and the SISO Design Tool. The LTI Viewer is basically used to plot 
graphs of the system response due to various inputs and the SISO Design Tool is used to design 
single input-single output systems, that is systems for which the input and output vectors have 
dimensions 1 by 1.  Information about the LTI Viewer is available from Help > Control System 
Toolbox > Getting Started > Analyzing Models > LTI Viewer and a viewer window can be 
launched from the Command window with
 
>> ltiview
 
We don’t comment on the SISO design tool since that would require knowledge of control 
theory, but we give an example of the use of LTI Viewer. Consider the system 
 

, , , .
 
To import the system to the LTI Viewer, we create a system object using the ss command. 
 
>> A=[0 1;-1 -1];
>> B=[0 1]';
>> C=[1 0];
>> D=0;
>> s1=ss(A,B,C,D)
 
a = 
       x1  x2
   x1   0   1
   x2  -1  -1
 
 
b = 
       u1
   x1   0
   x2   1
 
 
c = 
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       x1  x2
   y1   1   0
 
 
d = 
       u1
   y1   0
 
Continuous-time model.
 
Then from File > Import select s1 and click on the OK button. The s1 system will then appear in 
the LTI viewer.
 
 

 
Next, right click on that figure and select Plot Types > Impulse to get the following figure, which 
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is a plot of the response of the system to a unit impulse at time zero.
 

 
 
Optimization Toolbox
 
The Optimization Toolbox offers a rich variety of routines used for the minimization and 
maximization of functions under constraints. We will describe only two simple and commonly 
used examples. The first one is fminbnd which calculates the location in a given interval at 
which a function attains its minimum. Note that the maximum of a function  is equal to 
minus the minimum of ; hence we can use fminbnd to compute locations of maxima of 
functions too. Suppose now that we want to compute the minimum and maximum values of 

 in the interval . 
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Then we type in the command line:
 
>> x=fminbnd('x*exp(-x^2)',-1,1)
 
x =
 
   -0.7071
 
>> x*exp(-x^2)
 
ans =
 
   -0.4289
 
>> x=fminbnd('-x*exp(-x^2)',-1,1)
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x =
 
    0.7071
 
 
>> -(-x*exp(-x^2))
 
ans =
 
0.4289
 
The minimum and maximum values of  are -0.4289 and 0.4289 and are attained 
at -0.7071 and 0.7071 respectively. 
 
Next, consider the problem of linear optimization, which is frequently encountered in operations 
research and mathematical economics. The objective is to find n real numbers that minimize the 
linear expression
 
 
subject to the constraints:
 
 
or in matrix form, minimize   such that .
 
The problem can be solved via the function linprog. As an example consider the following 2-D 
linear optimization problem:
 
Minimize , so that the constraints 

, ,  ,   hold. 
 
To solve it we type:
 
>> c=[2 3];
>> A=[-3 4; 3 1; 1 -2; -2 -1];
>> b=[0 15 5 0]';
>> linprog(c,A,b)
>>ans =
 
     1.0000
          -2.0000
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Next we give a geometrical interpretation of this solution. It can be shown that the pair (x1,x2) 
that solves the problem, is one of the vertices of the quadrilateral in the following figure:
 

 
 
 
 
The edges of the trapezoid correspond to the optimization constraints and the points in its interior 
satisfy all of them, hence the solution must be attained in the trapezoid or on its boundary. Due to 
a theorem in linear optimization, the solution is attained at one of the trapezoids’ vertices, in this 
case at the point (1,-2).
 
 
Using Simulink
 
Simulink is a simulation tools library for dynamical systems. Any system in nature can roughly 
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be thought of as a “black box” receiving an input vector u and eliciting a unique output vector y. 
In the case that both u and y vary with time we are talking about dynamic systems. 
 

Associated with a system is the so-called state vector which loosely speaking contains the 
required information at time  that together with knowledge of the input for time greater than , 
uniquely determines the output for . A general continuous dynamical system can be 
modeled by using the following set of ordinary differential and algebraic equations:
 
 
for   and , where  are general (possibly non-linear functions). In the 
following we will consider only linear systems of the form:
 

         (1)
 
where   are matrices and  the state, input and output vectors respectively.
Of course the dimensions of A, B, C, D are such that the matrix manipulations on the right hand 
side of (1) are well defined.
 
Simulink Library Browser
 
Simulink can be launched by typing
 
>> simulink
 
in the Simulink icon in the Command window of the default Matlab desktop.
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The library’s functionalities are divided into eight groups (click on any of the category icons for 
both the UNIX or Windows versions). For example the categories Sources and Sinks contain 
various kinds of inputs and ways to handle or display the output respectively. Also, it contains the 
group Continuous that will be used later deals with dynamical systems.
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Construction/ Simulation of Dynamical Systems
 

In the following, we consider a simple physical example to illustrate the usage of Simulink. One 
of the simplest systems introduced in mechanics classes is the vibrating spring,

 

 

which can be modeled by the ordinary differential equation 
 

      (2)
 
Here  is the mass of the body supported by the spring;  and  are the viscous and spring 
friction coefficients respectively, and  is the force applied to the body. The unknown function 

 is the distance of the body from the equilibrium position. Our first observation is that the 
differential equation describing the motion of the body is of second order (in other words the 
highest differentiation order of the equation is 2). To reduce it to a system of differential 
equations of first order (so that we can use Simulink) we make the following substitution:
 

 
 
Then (1) becomes:
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or in matrix form:
 

   (3)
 
Here  and  are the state variables and  the input to the system. The output can be selected 
in various ways depending on what characteristics of the system are desired to be measured; it 
could be  (that is displacement),  (velocity) or a linear combination of , , and . For 
our purposes we simply define the output to be . That is, 
 
 

                        (4)
 
in matrix form.
 
 
Equations (3) and (4) constitute the representation of the system in the form (1), with
 

,   ,   ,   .
 
 Furthermore, we take , that is , . Our initial conditions 
are , ; that is at time  the body is located at a distance of 2 units from 
the equilibrium position and its velocity is 0. The next step is to build the system using Simulink. 
Clicking on the Create a new model button on the upper left corner of the Simulink library 
browser launches an untitled new model window. Next double click on the Continuous button in 
the Simulink Library Browser window, select the State-Space icon and drag it into the new model 
window.
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After double clicking on the dragged State-Space icon, the Function Block Parameters window 
appears in which we specify the matrices  and  as well as the initial condition vector. 
Note that the matrices are entered in the one row format described in section 3, but for large 
matrices it is more convenient to define ,  in the command line (possibly with other 
names) and simply enter their names in the block parameters window.
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In the following we double click the Sources icon to select an input for the system. Let's choose 
the input Constant and drag it into the new model window. Again, by double clicking on the 
dragged Constant icon we specify the value of the constant input. For our example we take .
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The output is selected by clicking on the Sinks button. Choose for example the Scope icon and 
drag it into the model window (Scope provides a graph of the system’s output).
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Next, connect the system blocks with arrows. For example, to connect the constant and state-
space blocks, click on the right arrow of the constant block and move the cursor to the left arrow 
of the state-space block while holding the left mouse key down. We can also add text on the 
model window by double clicking at any point of it and inserting the desired information. 
 

 
 
Then, from the model window toolbar, select Simulation > Configuration Parameters to specify 
the simulation parameters (the simulation initial and final time and the ODE solver to be used for 
example). In this example we choose . 
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Now that the system has been built up, we are ready to run the simulation, in other words 
numerically solve the system of ODEs to obtain the output . Simply, press the Start simulation 
button on the Simulation toolbar menu and then double click on the Scope icon to obtain a plot of 
the output.
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We observe that after time t approximately equal to 9, the displacement remains constant. 

Next we change the system’s input to a ramp by following the previous procedure. We specify 
the ramp input parameters by double-clicking on the Ramp icon and choosing slope=1, start 
time=0 and initial output=0. In the following figures we present the modified system and its 
response.
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As expected, since the force acting on the body is increasing in magnitude and doesn’t change 
direction, the distance from the rest point increases. Also, we consider the case of a step input, 
that is a force spontaneously changing its magnitude at some time . Again the step function 
parameters, are specified by double-clicking on the Step icon and choosing step time = 1, initial 
value = 0, and final value = 1.
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In the sequel, let's consider the case of zero force acting on the body, that is we have a constant 
input equal to zero. We expect that the body will eventually return to the rest position  and 
indeed this is what our model predicts.
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In all previous cases except the ramp input’s case, the system’s output eventually approaches a 
constant value. Let’s examine the case where viscous friction is negligible, that is  and 
again the input force is the constant 0 (double click on State-Space icon and adjust A to [0 1; -1 

http://www.utexas.edu/its-archive/rc/tutorials/matlab/ (131 of 145)11.09.2007 07:54:15



Matlab Tutorial

0]). We expect that the body will be moving internally, since no force exists to counterbalance the 
spring’s force acting on it. Indeed, the prediction of our model is consistent with the physical 
intuition. As we can see in the latter of next two figures the output of the system (displacement of 
the body) oscillates between the extreme values –2 and 2.
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In our last example we try to correct this behavior and actually make the system’s output 
approach the value 0 (that is to make the body return to the equilibrium position) by introducing a 
so-called feedback control law. More precisely we define a new input to the system which is not 
user supported as in the previous examples, but depends on the system’s output. In other words, 
the system’s output simultaneously defines its input.  Indeed, we define:
 

, where . The selection of the feedback gain matrix  is of course not 
arbitrary but we will not comment on its derivation.  In fact  can be selected in many different 
ways and it is the task of the control engineer to determine the best one, depending on design 
requirements and limitations. 
 
Then our system becomes:
 
 
but using Simulink we actually develop the equivalent formulation
 
 
 
In the next figures the feedback controlled system is presented along with its output. To construct 
this model drag the Gain blocks from the Math library (and again double click on them to specify 
the gain matrices). Also, in order to rotate a Gain block simply right-click on it, choose the 
Format option from the pull-down menu that appears and then select the options Rotate block or 
Flip block. Finally, note that the body returns to its equilibrium position as it was desired.
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The output from the State Space block  feeding into the Gain blocks is now needs to be a two 
element vector so that the C matrix needs expansion to [ 1 0; 0 1] and the D matrix needs 
expansion to [0 0]'.
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Note that the K vector for the feedback gain is the one we used above, [0 -1]
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whereas the gain feeding the scope will need to have a K vector [1 0].  Output to the scope will 
then be the just the displacement.
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Simulink Subsystems
 
In Matlab programming, functions are used to encapsulate a computation so that it can be used 
repeatedly without having to duplicate code wherever it is needed. In addition, a function can 
insulate its calling script from having to worry about its implementation details.  In Simulink, 
subsystems play a similar role. Using subsystems in Simulink has these advantages:
 

•        It helps reduce the number of blocks displayed in the model window.
•        Functionally related blocks can be kept together.
•        It permits the establishment of a hierarchical block diagram, wherein a Subsystem 
block is on one layer and the blocks that make up that subsystem are on another.

 
In Simulink, a subsystem can be created in two ways:

•        One way is to add the blocks that make up the subsystem to the model, then group 
those blocks into a subsystem.
•        The other way is to first add a Subsystem block to the model, then open that block and 
install the component blocks of the Subsystem to the subsystem window.

 
 
 
Grouping existing blocks into a Subsystem
 
If a model already contains the blocks needed for a desired subsystem, you can create the 
subsystem by grouping those blocks:
 

1.  Enclose the blocks and connecting lines that you want to include in the subsystem within a 
bounding box.  For example, the figure below shows a model that does signal processing. 
The Abs, Sine Wave Function and Add blocks that do the signal conversions are selected 
within a bounding box.  The box illustrated can be selected by clicking the mouse at the 
upper left position, and then while depressing the right mouse button drag to the lower 
right position
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      The components within the box will be selected when the mouse button is released.        
 
2.  Choose Create Subsystem from the Edit menu. Simulink replaces the selected blocks with 

a Subsystem block. The figure below shows the model after the Create Subsystem 
command has been chosen. If necessary, the Subsystem block can be resized so that the 
port labels are readable).

 
 
 
Creating a Subsystem by adding a Subsystem block
 
The process of creating a subsystem before adding its component blocks usually consists of three 
major steps:
 

1 Copy the Subsystem block from the Ports & Subsystems library into your model.
2 Open the Subsystem block by double-clicking it. Simulink opens the subsystem in the 
current or a new model window, depending on the model window reuse mode that you 
selected.
3 In the empty Subsystem window, create the subsystem. Use Inport blocks to represent input 
from outside the subsystem and Outport blocks to represent external output.
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Here is an example which models an integrator system. 
 

1.  From the Simulink Library Browser, go to the Ports & Subsystems subdirectory. 
     Click-drag the Atomic Subsystem block into the Model window. 
2.  Open the subsystem block by double-clicking the subsystem block. 
3.  Delete the line connecting In1 block and Out1 block. 
4.  Insert blocks into this subsystem window as prescribed in the figure below and 
     then  fix the block layout and connections between blocks.
 

 
5. Click on the Go to parent system button or choose View > Go to the Parent from the 
navigation bar.   This will send you back to the underlying Model window. 
6. Go back to the Simulink Library Browser and add sine wave function and scope blocks 
     into the Model window as described below.
 
 

 
7. Run the simulation by clicking the Start button on the toolbar or by selecting Simulation > 
Start from the navigation bar. Results can be seen by double clicking on the scope block.
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Simulink S-Functions
 
 
What Is An S-Function?
 
S-functions can be used to add your own custom blocks to a Simulink model. An S-function is a 
computer language description of a Simulink block written in Matlab, C, C++, Fortran, or Ada. 
The form of an S-function is very general and it can accommodate continuous, discrete, and 
hybrid systems.
 
How S-Functions Work
 
Execution of a Simulink model proceeds in stages. An S-function is comprised of a set of 
callback methods that perform tasks required at each simulation stage. During simulation of a 
model, at each simulation stage, Simulink calls the appropriate methods for each S-Function 
block in the model. Tasks performed by S-function methods include

 
•        Initialization. In this stage, Simulink initializes the S-function. Specifically, this 
process includes initializing a simulation structure; setting the number and dimensions 
of input and output ports; setting the block sample times; and allocating storage areas 
and the sizes array.
•        Calculation of next sample hit. This stage calculates the time of the next sample hit 
if a variable sample time block has been created,.
•        Calculation of outputs in the major time step. After this call has been completed, all 
the output ports of the blocks are valid for the current time step.
•        Update of discrete states in the major time step. In this call, all blocks should 
perform once-per-time-step procedures.
•        Integration. This call is applicable to models with continuous states and/or non-
sampled zero crossings. If an S-function has continuous states, Simulink calls its output 
and derivative portions at minor time steps to compute the states for your S-function. If a 
MEX S-function written in C has non-sampled zero crossings, then Simulink calls its 
output and zero-crossings portions at minor time steps to locate the zero crossings.

 
Implementing S-Functions
 
An S-function can be implemented as either an m-file or a MEX file. Here we focus on m-file 
implementations.  An m-file S-function consists of a Matlab function having the following form:
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                        [sys,x0,str,ts]=f(t,x,u,flag,p1,p2,...)
 
where f is the S-function's name, t is the current time, x is the state vector of the corresponding S-
function block, u represents the block's inputs, flag indicates a task to be performed, and p1, 
p2, ... are parameters defining the block. During simulation of a model, Simulink repeatedly 
invokes the S-function f, using flag value to indicate the task to be performed for a particular 
invocation. Each time the S-function performs the task, it returns the result in a structure having 
the [sys,x0,str,ts]=f(t,x,u,flag,p1,p2,...) format.
 
A template implementation of an m-file S-function, sfuntmpl.m, is present in the 
toolbox>simulink>blocks location from the top level matlab installation directory or folder. The 
template consists of a top-level function and a set of skeleton subfunctions, each of which 
corresponds to a particular value of flag. The top-level function invokes the subfunction indicated 
by flag. The subfunctions, which are called S-function callback methods, perform the tasks 
required of the S-function during simulation. A table listing the contents of an m-file S-function 
that follows this standard format can be seen within the Matlab help files at Full Product Family 
Help> Simulink> Overview of S-Functions > Implementing S-Functions from the Help 
navigation bar menu.
 
It is recommended that the structure and naming conventions of the template be followed when 
creating m-file S-functions.
 
An example of an m-file S-Function is given below.
 
Structure of S-Function code m-files
 
The following is an example that creates a block which takes an input scalar signal and multiplies 
it by three. The m-file code containing the S-function, shown below, is modeled on the S-
function template sfuntmp1.m and would have a file name “timesthree.m”.
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Here we deconstruct the S-function file to understand it.
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1. The first line specifies the input and output arguments.
 
function [sys,x0,str,ts] = timesthree(t,x,u,flag)
 
2. After the first line, the S-function file is split into the different cases determined by flag.  As 
shown in the codes, it only considers case 1 and 3.  For cases 1, 2, 4, and 9, its simply sets sys=
[].  The last two lines of the timesthree function are to catch an exceptional case where a bug has 
occurred during the Simulink run. 
 
3. For case 0 (initialization), the function mdlInitializeSizes invokes the simsizes command. 
Without arguments, simsizes will create a structure variable which we can then fill with the initial 
values.  
 
sizes = simsizes;
sizes.NumContStates= 0;
sizes.NumDiscStates= 0;  
sizes.NumOutputs=    1;
sizes.NumInputs=     1;
sizes.DirFeedthrough=1;
sizes.NumSampleTimes=1;
 
Using the command simsizes again with the structure variable as the argument actually translates 
the values in the structure sizes into a row vector which then gets sent to Simulink via sys:         
 
sys = simsizes(sizes);
 
It then initializes the states (x0), state ordering strings (str) and sample times (ts).
 
x0 = []; % No continuous states
str = []; % No state ordering
ts = [-1 0]; % Inherited sample time
 
4. For case 3 (output calculations), function mdlOutputs performs the calculations:
 
 sys = 3*u;
 
To illustrate this function, consider a time vector
 
>> t = [1 2 3];
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and a state vector 
 
>> x = [1 1];
 
and an input argument
 
>> u = 4;
 
Then the initialization procedure is
 
>> timesthree(t,x,u,0)
 
ans =
 
     0     0     1     1     0     1     1
 
and the calculated output is
 
>> timesthree(t,x,u,3)
 
ans =
 
    12
 
Insertion of an S-function into Simulink
 
In the Simulink Library browser, go to the [User-Define Functions] subdirectory.  Then drag-
drop the S-Function block. For this example, connect a Step signal to the input of an S-Function 
block and connect the output of the S-Function block to a Scope. Then double-click on the S-
function block to open the dialog box. In the dialog box, change the Sfunction name to timesthree 
and leave the parameters empty.  The simulation can now be run and its output checked from 
Scope.
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S-Function Test Example
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